# Table Of Contents

## Getting Started
- About the ImageNow toolbar ........................................................................................................................................ 1
- What is ImageNow? ................................................................................................................................................... 1
- About the ImageNow toolbar ...................................................................................................................................... 2
- About the ImageNow Explorer window .......................................................................................................................... 3
- About the ImageNow Viewer window .......................................................................................................................... 3
- File Types .................................................................................................................................................................. 4
- About using the ImageNow Help system ....................................................................................................................... 5
- Contact Product Support ................................................................................................................................................ 6
- Shortcuts in ImageNow .................................................................................................................................................. 8
  - ImageNow Explorer ................................................................................................................................................... 8
  - ImageNow Viewer ...................................................................................................................................................... 8
- Copyright and trademark attributions .............................................................................................................................. 11

## Viewing Documents
- About viewing a document ............................................................................................................................................... 12
- View a document .......................................................................................................................................................... 12
- View a document in its original application .................................................................................................................. 13
- Add or view notes on a document ................................................................................................................................ 13
- Changing a document's appearance ............................................................................................................................... 13
  - Set a default view ........................................................................................................................................................ 13
  - Automatically tile a document's pages ........................................................................................................................ 13
  - Resize a document ........................................................................................................................................................ 13
  - Reverse the colors of a document image ..................................................................................................................... 14
  - Rotate a document ....................................................................................................................................................... 14
  - Show XY coordinates .................................................................................................................................................. 14
  - View document properties ......................................................................................................................................... 14
  - Zoom in and out of a document ................................................................................................................................ 14
- Customizing Grids .......................................................................................................................................................... 14
  - Add or remove a grid column ...................................................................................................................................... 14
  - Refresh a grid .............................................................................................................................................................. 15
  - Reorder a grid column ................................................................................................................................................ 15

## Document Processing
- About processing documents ............................................................................................................................................... 16
- Copy a document ............................................................................................................................................................ 16
- Move a document .......................................................................................................................................................... 16
- Delete a document .......................................................................................................................................................... 17
- Quality Assurance .......................................................................................................................................................... 17
  - What is quality assurance? ......................................................................................................................................... 17
  - Open in QA mode ........................................................................................................................................................ 17
  - Quality assure a document or batch ............................................................................................................................ 18
Rescan a page in a batch ................................................................. 18
Commit entire batch as QA complete ........................................ 19
Suspend or stop QA batch processing ........................................ 19
Linking Documents ........................................................................ 19
What is linking? ............................................................................ 19
Link a document or batch ............................................................ 19
Put a page on hold during linking .............................................. 20
Discard a page during linking .................................................... 20
Turn on the Relink icon ............................................................... 20
Suspend linking a batch .............................................................. 21

ImageNow Toolbars ..................................................................... 22
Annotation toolbar ....................................................................... 22
ImageNow Explorer toolbar ....................................................... 23
ImageNow toolbar ........................................................................ 24
ImageNow Viewer toolbar ........................................................... 24
ImageNow Link Viewer toolbar ..................................................... 26
ImageNow PackageViewer toolbar .............................................. 27
ImageNow Project Viewer toolbar .............................................. 28
ImageNow QA Viewer toolbar .................................................... 28
Version Control toolbar .............................................................. 30
ImageNow Workflow Viewer toolbar .......................................... 30

Setting ImageNow Options .......................................................... 32
Customize your ImageNow toolbar ............................................. 32
Show or hide the ImageNow menu bar ....................................... 32
Set default ImageNow feature options ...................................... 32
Change Message Center options .............................................. 33
Change your version control folder ......................................... 33
Change e-mail options .............................................................. 33
Change Date and Time format .................................................. 34
Change your ImageNow System Tray settings ......................... 34
Disable the ImageNow System Tray icon ................................. 34
Set LearnMode options ............................................................ 35

Basic Tasks .................................................................................. 36
Customize ImageNow Explorer .................................................. 36
Customize ImageNow Viewer ...................................................... 38
Capture a document ..................................................................... 38
Capture a package of documents ............................................. 39
Print a document .......................................................................... 39
Import a document using ImageNow Printer ............................. 40
Email a document ......................................................................... 40
Export a document ....................................................................... 40
Search for a document ............................................................ 40
Dock task panes in another position ........................................................................................................ 41
Turn on the Message Center ......................................................................................................................... 41

Search .............................................................................................................................................................................. 42
About searching for a document ......................................................................................................................... 42
Search by an index key (Simple) ......................................................................................................................... 42
Search using multiple index keys (Advanced) ...................................................................................................... 43
Create a search query ........................................................................................................................................ 44
Run a stored search query ................................................................................................................................. 44
Rename a saved query .................................................................................................................................... 45
Delete a query ..................................................................................................................................................... 45
Set search options ........................................................................................................................................... 45
Content Search ...................................................................................................................................................... 46
Search the content of documents (Simple) ........................................................................................................ 46
Search the content of documents (Advanced) .................................................................................................... 46
Change content search highlight color ............................................................................................................... 49

Annotations ................................................................................................................................................................. 50
What is an annotation? ........................................................................................................................................ 50
Add an annotation ............................................................................................................................................... 50
Show or hide annotations ................................................................................................................................... 50
View annotation properties .................................................................................................................................. 51
Delete an annotation ............................................................................................................................................ 51
Types of Annotations .......................................................................................................................................... 51
Add an arrow annotation .................................................................................................................................... 51
Add a check annotation ...................................................................................................................................... 52
Add a highlight annotation ............................................................................................................................... 53
Add a line annotation ....................................................................................................................................... 53
Add an oval annotation .................................................................................................................................... 54
Add a pen annotation ........................................................................................................................................ 55
Add a rectangle annotation ............................................................................................................................... 55
Add a redact annotation .................................................................................................................................... 56
Add a stamp annotation ..................................................................................................................................... 57
Add a sticky note annotation ............................................................................................................................. 57
Add a text annotation ......................................................................................................................................... 58
Add a URL annotation ....................................................................................................................................... 58
Add a sound or picture as an annotation .......................................................................................................... 59
Customizing Annotations ........................................................................................................................................ 60
Move or resize an annotation ............................................................................................................................ 60
Add a time, date, or user name code to a stamp annotation ........................................................................... 60
Modify an annotation instance ......................................................................................................................... 61

Workflow ........................................................................................................................................................................ 63
About ImageNow Workflow ................................................................................................................................. 63
Add an item to workflow .................................................................................................................................. 63
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove an item from workflow</td>
<td>63</td>
</tr>
<tr>
<td>Archive an item in workflow</td>
<td>64</td>
</tr>
<tr>
<td>Change document keys in workflow</td>
<td>64</td>
</tr>
<tr>
<td>Route a document in workflow</td>
<td>64</td>
</tr>
<tr>
<td>Set the status of a document in workflow</td>
<td>65</td>
</tr>
<tr>
<td>View an item in workflow</td>
<td>65</td>
</tr>
<tr>
<td>Recall an item in workflow</td>
<td>65</td>
</tr>
<tr>
<td>Place a workflow item on hold</td>
<td>65</td>
</tr>
<tr>
<td>View recently routed items</td>
<td>66</td>
</tr>
<tr>
<td>View workflow history</td>
<td>66</td>
</tr>
<tr>
<td>Process an item in workflow</td>
<td>66</td>
</tr>
<tr>
<td>View columns for Workflow</td>
<td>67</td>
</tr>
<tr>
<td>Mark an item as pending</td>
<td>67</td>
</tr>
<tr>
<td>Workflow toolbar options</td>
<td>67</td>
</tr>
<tr>
<td>View recently routed items</td>
<td>66</td>
</tr>
<tr>
<td>View workflow history</td>
<td>66</td>
</tr>
<tr>
<td>Process an item in workflow</td>
<td>66</td>
</tr>
<tr>
<td>View columns for Workflow</td>
<td>67</td>
</tr>
<tr>
<td>Mark an item as pending</td>
<td>67</td>
</tr>
<tr>
<td>Workflow toolbar options</td>
<td>67</td>
</tr>
<tr>
<td>Viewing Log Files</td>
<td>69</td>
</tr>
<tr>
<td>What is the Controller Log file?</td>
<td>69</td>
</tr>
<tr>
<td>Create the Controller Log file</td>
<td>69</td>
</tr>
<tr>
<td>View the Controller Log file</td>
<td>69</td>
</tr>
<tr>
<td>Delete the Controller Log file</td>
<td>69</td>
</tr>
<tr>
<td>Projects</td>
<td>70</td>
</tr>
<tr>
<td>What is a Project?</td>
<td>70</td>
</tr>
<tr>
<td>Create a Project</td>
<td>71</td>
</tr>
<tr>
<td>Add a document to a Project</td>
<td>71</td>
</tr>
<tr>
<td>Remove a document from a Project</td>
<td>72</td>
</tr>
<tr>
<td>Delete a Project</td>
<td>72</td>
</tr>
<tr>
<td>Add a Project to workflow</td>
<td>73</td>
</tr>
<tr>
<td>Modify general properties of a Project</td>
<td>74</td>
</tr>
<tr>
<td>Search and view documents by Project</td>
<td>74</td>
</tr>
<tr>
<td>Change custom properties on a Project</td>
<td>74</td>
</tr>
<tr>
<td>View related Projects</td>
<td>75</td>
</tr>
<tr>
<td>Custom Properties</td>
<td>76</td>
</tr>
<tr>
<td>What are custom properties?</td>
<td>76</td>
</tr>
<tr>
<td>View custom property data</td>
<td>76</td>
</tr>
<tr>
<td>Edit custom property data</td>
<td>76</td>
</tr>
<tr>
<td>Search on custom properties</td>
<td>77</td>
</tr>
<tr>
<td>Document Management</td>
<td>78</td>
</tr>
<tr>
<td>What is Document Management?</td>
<td>78</td>
</tr>
<tr>
<td>Add a document to Version Control</td>
<td>79</td>
</tr>
<tr>
<td>Check in or check out a document</td>
<td>79</td>
</tr>
<tr>
<td>Edit a versioned document in its native application</td>
<td>80</td>
</tr>
</tbody>
</table>
Getting Started

About the ImageNow toolbar

The ImageNow toolbar is extremely flexible and configurable, allowing you to change the toolbar size, button size, button text, and much more. As with previous versions of ImageNow, all of the functions and documents you need are only one mouse click away. These options below change depending on your security privileges.

If you click Applets, Batch, Documents or Workflow, each of these links will take you to the ImageNow Explorer.

**Applets** Takes you to the Applet list in the ImageNow Explorer, which contains your applets that integrate information between ImageNow and your host application, such as a student record.

**Batches** In the ImageNow Explorer, you can quality assure and link your batches of scanned files in order to create ImageNow documents.

**Documents** Use this option to search for ImageNow documents.

**Projects** Provides you with a method of organizing like documents and setting customized properties on those documents.

**Workflow** Click this button to process workflow items in your workflow process, starting in the ImageNow Explorer grid.

**Capture** Set up your scanning devices and capture profiles using this entry point, and then click this Capture button anytime you want to scan or collect documents in some other mode.

**Manage** For administrators only, Manage lets you configure your security settings across ImageNow features, your users and groups, annotations and workflow process, and other custom properties.

What is ImageNow?

This Help file contains the most current and accurate technical documentation on how to use ImageNow, version 6. ImageNow adapts to your business processes and ensures that all documents are secure, quickly retrievable, and tied to the files and applications you want, with comments and annotations as needed. ImageNow can also capture and manage data from e-mails, reports, and non-image file formats such as DOC and TXT. The following figure shows the ImageNow toolbar, which is your entry point into ImageNow. From the ImageNow toolbar, you can view, scan, process, and search for documents, as well as perform administrative configuration and management tasks for your file system.
Processing documents involves three essential tasks that let you capture document images and any unstructured data into ImageNow and integrate them with your host application. The first step is to capture the documents into ImageNow, which is typically done by scanning or importing them from a computer. Next, you review each document to ensure they were captured to the standards of quality that you need. After you quality assure your documents, you link them to index keys so that they are grouped in a logical order and matched to records in your host application. After these required steps are completed, you can use numerous features in ImageNow, such as annotations, e-mail and export, and workflow.

If you upgraded to ImageNow 6 from a previous version, note that this version contains many new features. To observe the new features and other enhancements available in ImageNow 6, refer to the What’s New in ImageNow 6 document on www.imagenow.com.

About the ImageNow toolbar

The ImageNow toolbar is extremely flexible and configurable, allowing you to change the toolbar size, button size, button text, and much more. As with previous versions of ImageNow, all of the functions and documents you need are only one mouse click away. These options below change depending on your security privileges.

If you click Applets, Batch, Documents or Workflow, each of these links will take you to the ImageNow Explorer.

Applets Takes you to the Applet list in the ImageNow Explorer, which contains your applets that integrate information between ImageNow and your host application, such as a student record

Batches In the ImageNow Explorer, you can quality assure and link your batches of scanned files in order to create ImageNow documents.

Documents Use this option to search for ImageNow documents.

Projects Provides you with a method of organizing like documents and setting customized properties on those documents.

Workflow Click this button to process workflow items in your workflow process, starting in the ImageNow Explorer grid.

Capture Set up your scanning devices and capture profiles using this entry point, and then click this Capture button anytime you want to scan or collect documents in some other mode.

Manage For administrators only, Manage lets you configure your security settings across ImageNow features, your users and groups, annotations and workflow process, and other custom properties.
About the ImageNow Explorer window

In ImageNow Explorer, you can navigate through all of the ImageNow grids, including Batches, Documents, Projects, and Workflow. Each row in the grid represents a document that resides in ImageNow or is in an intermediate status such as QA or Linking. You can display the ImageNow Viewer window for any item in the grid by double-clicking its row.

You can use the toolbar buttons to open, email, print, add notes to, refresh, delete, or display the properties of the selected document. You can also reposition any of the toolbars to the top, left, right, or bottom side of the Explorer grid.

In the Views pane, you can switch between following groupings of documents:

- **Applets** view displays the document row (specifically, the document key values) that match the record currently selected in the external program, such as AP, HR, or student records management.
- **Batches** view displays one or more groups of pages that are ready for QA or Linking.
- **Documents** view displays the results of the search you define in the Simple or Advanced tab.
- **Projects** view displays any projects that you have defined. Opening a Project row displays the documents in the Project.
- **Workflow** view displays any documents that reside in the workflow and queue you selected in the tree.

About the ImageNow Viewer window

ImageNow Viewer lets you expand and display any item that appears in the grid of the ImageNow Explorer window. Items that can appear on this grid include batch pages and documents in a workflow queue.
In addition to a resizeable view of the document you opened, the viewer window includes a Tasks pane, Properties pane, Thumbnails pane, and others, depending on how ImageNow is configured on your computer.

- From the Tasks pane, you can perform all routine tasks on the item displayed in the document area.
- In the Properties pane, you can enter or change values of document keys for the item displayed in the document area.
- In the Thumbnails pane, you can double-click a different page of a multiple-page document to display it in the document area.

File Types

ImageNow can capture, index, and store any type of file, including Microsoft Office, Adobe, CAD, and media files. The ability of ImageNow to perform actions on these files, after capturing and storing them, is constrained by file type:

- You can rotate and annotate files of type TIFF, JPG, GIF, BMP, and PNG.
- Annotating Microsoft Office documents requires editing them in their associated application and saving those changes in ImageNow. This is facilitated by the Launch Associated Application button in the toolbar of the ImageNow Viewer.
The ImageNow Viewer can open over 200 file types; it does not require the native application to view these documents.

Movie files and other large files (greater than 100MB) are not recommended for use with ImageNow other than storing them in ImageNow.

About using the ImageNow Help system

The ImageNow Help system contains a set of topics designed to help you to complete tasks in ImageNow. Good Help systems advocate for the customer, and aim to translate any difficult areas into your own language so that you can easily identify the Help you need. The content in ImageNow Help is categorized into four types of Help topics or card types: Procedure, Concept, Reference, and Troubleshooting.

If end-user based, the majority of information in any Help system is procedural; if the Help is optimized for programmers, the information is mainly reference material, containing examples. The ImageNow Administration Help system contains mostly procedural topics, and aims to support this content with conceptual, reference and troubleshooting topics.

When you are working in the ImageNow interface and are not sure how to move forward with the next step, open Help, and ask your question. An intelligent result set of answers will return, from which you can choose the type of help you want. The goal of the ImageNow Help system is to provide you with the answers you need that are documented in a manner that is easy to read, conscious of your time, and ensures that you have a successful experience in the Help.

Topic titles are your clue

Procedure topics Begin with an imperative verb cue and the topics almost always contain numbered steps that walk you through completing the task that is reflected in the topic title. For example, "Copy a Capture Profile." Copy is the action, and the Capture Profile is being acted upon.

Concept topics Begin with "About" or "What is..." Conceptual topics typically cover a feature area or subsystem, and aim to give you just the conceptual sound-bites you need to makes sense of all the procedures that are documented for that area. Remember, Help systems are not manuals; they are not online books. The ImageNow Help system is optimized to answer a question that you have in the moment while working with ImageNow. Concepts and reference information aim to support you in the completion of tasks in a timely manner.

Reference topics Are positioned as a noun phrase or string such as "Shortcut Keys" or "Recognition Agent methods and modules." Reference topics contain tables of information that you can look up in order to find a description for how a particular user interface element or script works in ImageNow. Concepts and reference information aim to support you in the completion of tasks in a timely manner. As appropriate, you will be directed to the ImageNow web site for additional reference material.

Troubleshooting topics Begin with "Troubleshoot" and outline in first-person statements the problem you may be having, and then documents a solution, typically in step-by-step format. The troubleshooting topic type assumes that the user has tried a task and not completed it successfully, that the user has knowledge about the feature area or task he or she is trying to complete. Regular procedure cards do not assume that a first attempt has been made to complete the task, and steps are documented from start to finish for all levels of users.
More about ImageNow Help

Perceptive Software builds Help and other documentation files for each new product release, and regularly publishes Help to www.imagenow.com. Go to the Support Portal, browse to the Documentation section, and then click the associated hyperlink to view the latest Help for the products you run. Optionally, from the ImageNow Client via the ImageNow Help menu, you can elect to retrieve Help directly from the Web site, and not the .chm file residing locally on your computer. In ImageNow, some Help is scoped or focused to provide information on just that area you are working in. For example, when you need help about how to add a script to a workflow queue, from the iScript Editor, an iScript Help file is available along with the larger ImageNow Administrator Help file.

Contact Product Support

Product Support is available 24 hours a day during the work week from Monday to Friday, and on weekends 24 hours a day via the Perceptive Software Call Center, which will route all support requests to the on-call Product Support Team members according to the severity of the issue being experienced.

You must be a registered user to access the Perceptive Software Product Support Portal and your company's SMSA must be current. When contacting Product Support with a new issue, provide the following information:

• Your name, company name, and phone number.
• Version of ImageNow.
• Type of operating system (for example, Microsoft Windows XP).
• Third-party software being used in conjunction with ImageNow (for example, scanner drivers, optical file systems).
• Complete description of the issue, including steps to reproduce it.
• Exact wording of any error messages displayed when you encountered the problem.
• Environment affected - Production, Test or Failover server?
• Type of database you run.

Locations

Perceptive Software is the world's leading manufacturer of image enabling tools for document imaging and management solutions. Perceptive Software is widely recognized as a technology leader in integrating document imaging with existing applications, providing a whole new way for organizations to leverage their investment. Contact Perceptive Software to find out about the latest of the ImageNow family of products, upgrade options, prices, and more. If you have a technical question or problem, contact Product Support.

Perceptive Software, Inc., Headquarters
North America Customers

<table>
<thead>
<tr>
<th>Address:</th>
<th>Perceptive Software, Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>22701 West 68th Terrace</td>
</tr>
<tr>
<td></td>
<td>Shawnee, Kansas  66226</td>
</tr>
<tr>
<td></td>
<td>USA</td>
</tr>
</tbody>
</table>

| Telephone: | (800) 941-7460 |
|           | (913) 422-7525 |

| Fax:       | (913) 422-3820 |
### Perceptive Software Inc., UK Ltd.
#### European Customers

<table>
<thead>
<tr>
<th></th>
<th>Details</th>
</tr>
</thead>
</table>
| **Address:**     | Venture House  
Arlington Square  
Downshire Way  
Bracknell  
Berkshire RG12 1WA  
United Kingdom |
| **Telephone:**   | (44) (0) 1344 742849             |
| **Fax:**         | (44) (0) 1344 742877             |
| **Web Site:**    | www.imagenow.com                 |
| **Online Help Web Site:** | http://www.imagenow.com/supportportal.nsf/onlinehelp.shtml |
| **Support Web Site:** | support.imagenow.com |
| **Product Support:** | eurosupport@imagenow.com |
| **Sales and Info:** | euroinfo@imagenow.com |
| **Business Issues:** | admin@imagenow.com |

### Perceptive Software Inc., Australia
#### Australasian Customers

<table>
<thead>
<tr>
<th></th>
<th>Details</th>
</tr>
</thead>
</table>
| **Address:**     | 1010 Doncaster Road  
East Doncaster Victoria  3109  
Australia |
| **Web Site:**    |                                   |
| **Online Help Web Site:** | http://www.imagenow.com/supportportal.nsf/onlinehelp.shtml |
| **Support Web Site:** |                                   |
| **Product Support:** |                                   |
| **Sales and Info:** |                                   |
| **Business Issues:** |                                   |
Shortcuts in ImageNow

Many ImageNow functions can be performed using shortcut keys. Shortcuts key functions vary depending on which grid or component of ImageNow you are using. The following shortcuts are available:

**ImageNow Explorer**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + O</td>
<td>Open File</td>
</tr>
<tr>
<td>Ctrl + M</td>
<td>E-mail File</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Export File</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print File</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>File Properties</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Duplicate</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Edit Document Keys</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select All</td>
</tr>
<tr>
<td>Del</td>
<td>Delete</td>
</tr>
<tr>
<td>F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>F11</td>
<td>Views</td>
</tr>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
</tbody>
</table>

**ImageNow Viewer**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
</table>


<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl + + (number pad)</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Ctrl + - (number pad)</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>F2</td>
<td>Resize Fit Image</td>
</tr>
<tr>
<td>F3</td>
<td>Resize Fit Width</td>
</tr>
<tr>
<td>F4</td>
<td>Resize Fit Height</td>
</tr>
<tr>
<td>Alt + Left Arrow</td>
<td>Rotate Left</td>
</tr>
<tr>
<td>Alt + Right Arrow</td>
<td>Rotate Right</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Pan Image Up</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Pan Image Down</td>
</tr>
<tr>
<td>Ctrl + Up Arrow; Home</td>
<td>Top of Image</td>
</tr>
<tr>
<td>Ctrl + Down Arrow; End</td>
<td>Bottom of Image</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Left Margin</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Right Margin</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Go to Page</td>
</tr>
<tr>
<td>Ctrl + Page Down</td>
<td>Next Page</td>
</tr>
<tr>
<td>Ctrl + Page Up</td>
<td>Previous Page</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>First Page</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>Last Page</td>
</tr>
<tr>
<td>F6</td>
<td>Scale To Gray (Toggle)</td>
</tr>
<tr>
<td>Alt + End</td>
<td>Reset Pointer (Disable Current Annotation)</td>
</tr>
<tr>
<td>Ctrl + Click</td>
<td>Select Annotation</td>
</tr>
<tr>
<td>F7</td>
<td>View Properties</td>
</tr>
<tr>
<td>F8</td>
<td>Show Keywords</td>
</tr>
<tr>
<td>F9</td>
<td>Thumbnails</td>
</tr>
<tr>
<td>F11</td>
<td>Invert</td>
</tr>
</tbody>
</table>

**Batch Q/A**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Spacebar</td>
<td>Page OK</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Discard Page</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancel</td>
</tr>
</tbody>
</table>
### Batch Link

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + L</td>
<td>Link Page</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Link Commit</td>
</tr>
<tr>
<td>Ctrl + K</td>
<td>Group and Link</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Discard Page</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Hold Page</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

### Batch Grid

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Process Selected</td>
</tr>
<tr>
<td>Del</td>
<td>Delete Selected</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scroll Down</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll Up</td>
</tr>
<tr>
<td>F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Ctrl + I; Alt + Enter</td>
<td>Properties</td>
</tr>
</tbody>
</table>

### Documents Grid

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>View Selected</td>
</tr>
<tr>
<td>Del</td>
<td>Delete Selected</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scroll Down</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll Up</td>
</tr>
<tr>
<td>Ctrl + Page Down</td>
<td>Page Down</td>
</tr>
<tr>
<td>Ctrl + Page Up</td>
<td>Page Up</td>
</tr>
<tr>
<td>F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Find</td>
</tr>
<tr>
<td>Ctrl + I; Alt + Enter</td>
<td>Properties</td>
</tr>
<tr>
<td>Ctrl + K</td>
<td>Keywords (Notes)</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Column Select Right</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Column Select Left</td>
</tr>
<tr>
<td>Ctrl + Up Arrow</td>
<td>Sort Ascending</td>
</tr>
</tbody>
</table>
Copyright and trademark attributions

No part of this Online Help system may be reproduced in any way without the written consent of Perceptive Software, Inc. Information in this Help system is subject to change without notice. Examples are fictitious.

ImageNow and CaptureNow are registered trademarks of Perceptive Software, Inc. Other product names produced by Perceptive Software, Inc., are Perceptive Software trademarks.

All other brands and product names mentioned in this Online Help system are trademarks or registered trademarks of their respective owners.
Viewing Documents

About viewing a document

With ImageNow, you can automatically view documents that are linked to records in your primary or host software program. For example, if you are reviewing an account record in the host program, you may need to see invoices or purchase orders related to that account that have been scanned into ImageNow.

Using the Applets button

To start automatic display of ImageNow documents that are linked to your host program records, you'll select the applet that was defined for that program in the Applets drop-down list.

ImageNow Explorer Window

As soon as you have (1) opened your host program to a specific record and (2) opened the corresponding ImageNow applet, as described above, a grid of any linked documents appears in ImageNow Explorer. ImageNow automatic reads information from the host program screen and uses it to retrieve scanned documents and other stored objects. This means that, as you are working within your host program, you can view scanned documents that have been linked to the current host record.

ImageNow Viewer

When you double-click a row in the ImageNow Explorer, the item in that row is expanded and displayed in ImageNow Viewer, which has several modes for viewing and processing objects. Each mode (document, QA, Link, Package, Project, and Workflow) is designed for specific tasks and has its own toolbar. Though ImageNow Viewer always displays a common set of buttons, the exact options and toolbars available differ from mode to mode.

Specific modes of ImageNow Viewer are automatically opened, based on the task you are performing. The current ImageNow Viewer mode is displayed in the window's title bar.

View a document

1. Open the record in your host program for which you want to view any documents scanned into ImageNow.
2. On the **ImageNow** toolbar, click the arrow next to the **Applets** button and select the applet that was defined for your host program. The linked documents for the record you selected in step one are displayed in **ImageNow Explorer**'s grid.

### View a document in its original application

1. In **ImageNow Explorer**, double-click the document.
2. In the **ImageNow Viewer** toolbar, click the **Launch associated application** button.

### Add or view notes on a document

1. In the **ImageNow Explorer** window, right-click the document to which you want to add notes, and then click Properties.
2. In the **Document Properties** dialog box, in the **Document Keys** tab, in the **Notes** box, add or view notes, and then click OK.

### Changing a document's appearance

#### Set a default view

1. In **ImageNow Explorer**, double-click any document.
2. In the **ImageNow Viewer**, arrange the panes (such as Tasks, Properties, Thumbnails, and Worksheets) as follows:
   - If the pane is closed, select it on the **View** menu.
   - If a pane is being minimized automatically and you want it to remain in the window, click the tack button in the upper right corner so that it changes to .
   - Drag each pane to the position you want.
3. Close **ImageNow Viewer**. When you reopen it, the panes reappear where you left them.

   **Note** To return **ImageNow Viewer** to its default state, on the **View** menu, click **Restore Default Settings**, and then in the **Restore Default Settings** dialog box, click **OK**.

#### Automatically tile a document's pages

1. In **ImageNow Explorer**, double-click the document that contains the pages you want to tile.
2. In the **ImageNow Viewer**, on the **File** menu, click Options.
3. In the **Viewer Options** dialog box, on the **General** tab, in the **Automatically tile pages** list, select Enabled, and then click OK.
4. In the **ImageNow Viewer**, on the **Window** menu, select **Automatic Tile** if it is not already enabled.

#### Resize a document

1. In **ImageNow Explorer**, double-click the document image you want to resize.
2. In **ImageNow Viewer**, on the **View** menu, point to **Resize** and then select the resize option you want.
Reverse the colors of a document image
1. In ImageNow Explorer, double-click the document to whose colors you want to reverse.
2. In ImageNow Viewer, on the View menu, click Invert.

Rotate a document
1. In ImageNow Explorer, double-click the document you want to rotate.
2. In ImageNow Viewer, on the View menu, point to Rotate and then select the option you want.
3. Optional: On the File menu, point to Settings, and then click Save Image Rotation to Server.

Show XY coordinates
1. In ImageNow Explorer, double-click the document.
2. In ImageNow Viewer, on the View menu, select Show XY Coords.
3. Move the pointer over the image. The XY Coordinates are displayed in the bottom left corner of the status bar.
   Note To hide the XY Coordinates, on the View menu, clear Show XY Coords.

View document properties
Do one of the following:
• In the ImageNow Explorer grid, right-click on a document, and then click Properties.
• In ImageNow Viewer, on the File menu, click Properties.

Zoom in and out of a document
1. In ImageNow Explorer, double-click the document that you want to zoom in or out.
2. On the ImageNow Viewer, on the View menu, click Zoom In or Zoom Out.
3. Repeat step 2 to continue to zoom in or out.

Customizing Grids
Add or remove a grid column
1. In the ImageNow Explorer toolbar, click the Table Control button.
2. In the Table Control dialog box, show (or hide) columns by selecting or clearing the corresponding Column Name check boxes, and then click OK.
Refresh a grid

- In the ImageNow Explorer toolbar, click the Refresh button.

Reorder a grid column

1. In the ImageNow Explorer toolbar, click in the heading of the column you want to move and then drag it to the left or right until red arrows appear above and below the heading.
2. Release the mouse button.
Document Processing

About processing documents

Processing documents involves three essential tasks for getting your documents and any unstructured data into ImageNow and then integrating the documents and data with your host application. The first step is to capture the documents into ImageNow, which is typically done by scanning or importing them from a computer. Next, you review each document to ensure they were captured correctly. After you have quality assured your documents, you link them to index keys, so they are grouped in a logical order and matched to records in your host application. After all these steps are completed, you can use other document features such as searching, viewing, printing, and exporting.

Scanning

ImageNow offers three methods of scanning and importing your documents. You can:

- Scan each document in on a one-by-one basis by using the Single Mode method.
- Scan several documents at once using the Batch Mode method.
- Scan or update baskets of documents using the Package Mode method.

Each method allows the options of bypassing QA, by sending documents directly to a workflow and linking them to document index keys automatically.

Quality Assurance

After you scan your documents, review them to ensure they are correct and complete.

Linking

After you have finished quality assuring your documents, link them to index keys that have been set up to work with your host application. You do this by matching your documents in ImageNow to records in your host application. Linking also gives you a way to group documents in ImageNow by storing them in Drawers. For example, documents scanned from different departments can be placed in corresponding drawers.

After documents are linked, you can display their pages whenever you open the corresponding records in your host application. You can also search for documents in ImageNow Explorer and inspect them in ImageNow Viewer. From there, you can export them, print them, annotate them, and add them to workflows.

Copy a document

1. In ImageNow Explorer, run a search to return the document that you want to copy.
2. Right-click the document and click Copy.

   ImageNow adds a copy of the document to the grid and appends "_1" to the document's name. Any additional copies will have names ending with "_2", "_3", and so forth.

Move a document

Note Moving a document means changing one or more of its document key values.
1. In ImageNow Explorer, run a search that returns the document that you want to move.
2. In the grid, select the document.
3. On the File menu, click Open.
4. In the ImageNow Viewer, in the Properties pane, under Document Keys, make your changes to the document by editing existing values or entering new ones in empty fields.
5. On the File menu, click Save.

Delete a document

1. In the ImageNow Explorer window, click the document you want to delete.
2. On the Edit menu, click Delete.
3. In the confirmation dialog box, click Yes.

Quality Assurance

What is quality assurance?

Quality assurance (QA) is the first step in processing documents after you scan or import them. During QA you verify that a document meets the standards of image quality that you require in order to store, view, and work with that document online. You achieve this goal this by deciding which pages to keep, discard, and if needed, rescan. Quality assurance occurs in the ImageNow Viewer in QA Mode.

Quality assuring documents is not required in ImageNow, but it is recommended. If you choose not to QA your documents, you have the option of bypassing this step and going directly to document linking.

You can QA a document only if it has been marked in ImageNow as Scanned or Imported, and its status is Ready for QA. Whether you are quality assuring one page, a document (which may contain multiple pages), or a batch of documents, you can always approve it as QA complete. If the first few pages meet the standards you require, you can approve all pages in the batch as QA complete. When a page does not meet your standards of quality assurance, you can rescan it, and the previous version of the scan is automatically discarded.

Finally, you can suspend a batch or stop processing it. If you suspend processing of the current batch, you remain in QA mode and can QA another document or batch and return to the original one later. If you stop processing, you end the current QA session. However, any time that you complete a QA process, ImageNow alerts you.

Open in QA mode

1. In the ImageNow Explorer window, in the Views pane, under Batches, select Ready for QA.
2. In the grid, select the batch you want to quality assure.
3. On the File menu, click Open.
Quality assure a document or batch

Whether you quality assure (Q/A) a document or batch, the Q/A process occurs in the PowerView Batch QA Mode.

1. In the ImageNow Explorer window, in the Views pane, under Batches, select Ready for QA.
2. In the grid, select the batch you want to quality assure.
3. On the File menu, click Open.
4. In the ImageNow Viewer, inspect the page. It is acceptable when it meets most or all of the following standards:
   - The scanned or imported image resembles the original document.
   - No part of the page is missing due to a scanner misfeed.
   - All critical elements of the document legible (for example, signatures, account numbers, and totals).
   - The document is properly oriented and aligned.
5. In the ImageNow Viewer toolbar, click one of the following buttons:
   - **Mark page as OK**. If the batch was a single page document, you are returned to the ImageNow Explorer. If you are quality assuring a multi-page batch, the next page of the document appears, and you must click **Mark page as OK** until you complete QA on all pages in the batch.
   - **Commit this batch**. Choose this option if you want to QA the batch without looking at all pages.
   - **Delete this page**. Discard the page if you want to remove it from the batch and the ImageNow server. If, instead, you want to replace it with a newly scanned version, click **Rescan this page**
   - **Rescan this page**. Rescan a page if it does not meet your standards of quality. Locate the original document and either place it back into the scanner feed or reimport it from a file system.
   - **Suspend this batch**. Choose this option if you want to review another batch and conclude the current QA session later.

Rescan a page in a batch

1. In the ImageNow Explorer window, in the Views pane, under Batches, select Ready for QA.
2. In the grid, select the batch that contains the page you need to rescan.
3. On the File menu, click Open and then the first page in the batch appears in ImageNow Viewer.
4. Insert the document you want to rescan into your scanner.
5. On the ImageNow Viewer toolbar, click the Rescan button, select the Scanning Profile you want to use to rescan your document, and then click OK.
   - After the document is scanned, you can quality assure it.
Commit entire batch as QA complete

1. In ImageNow Explorer, in the Views pane, under Batches, select Ready for QA.
2. In the grid, select the batch you want to quality assure.
3. On the File menu, click Open.
4. In the ImageNow Viewer toolbar, click the Commit this batch button. Then, the batch of documents is approved, and you are returned to ImageNow Explorer.

Suspend or stop QA batch processing

- On the ImageNow Viewer - QA toolbar, click the Suspend Batch button. The batch is put on hold for later processing, and you are returned to the ImageNow Explorer.

  Note To retrieve a suspended batch, in the ImageNow Explorer window, in the Views pane, under Batches, select Ready for QA. You can then select the batch you want to work with from the grid.

Linking Documents

What is linking?

After quality assuring a document or batch of documents, you'll need to link your documents to the appropriate records in your primary or host application. Linking occurs in ImageNow Viewer - Link Mode. When you link a document, some or all of its Document Key values are copied from the selected record in the host application. These are the values that allow ImageNow to retrieve the linked document from the ImageNow Server whenever the document's counterpart record in the host application is open. While working in Link mode, you can discard a page, relink a page, and link groups of pages. You can also suspend linking and resume the task at a later time.

Link a document or batch

1. On the ImageNow toolbar, click the arrow next to the Applet button and then select the applet that matches the host application that contains the record to you want to link to the document.
2. On the ImageNow toolbar, click the arrow next to the Batch button and then click Ready for Linking.
3. In ImageNow Explorer grid, select the batch you want to link.
4. On the File menu, click Open.
5. In the ImageNow Viewer - Link window, identify the displayed page from its name, account number, or other distinguishing information.
6. In the host application, display the corresponding record.
7. Position the ImageNow Viewer - Link window and the corresponding host application record so they are both visible on the screen.

  Note In a few cases, the entire host application record may need to be visible for linking to work.
8. In the ImageNow Viewer - Link toolbar, click the Link this page button 📆 to create a link between ImageNow and your host application. The Properties pane slides in from the right side of the window.

9. In the Properties pane, under Document Keys, enter required values if necessary, and then, in the ImageNow Viewer - Link toolbar, click the Save this page button 📁. The next page in the batch is displayed.

10. Repeat steps 5-9 as necessary until the entire batch is linked. You are then returned to ImageNow Explorer.

Put a page on hold during linking

1. On the ImageNow toolbar, click the arrow next to the Applet button and then select the applet that matches the host application that contains the record you want to link to the document.

2. On the ImageNow toolbar, click the arrow next to the Batch button and then click Ready for Linking.

3. In ImageNow Explorer grid, select the batch that contains the page you want to put on hold.

4. Work through any preliminary pages by linking or deleting them as necessary.

5. When you reach a page that should be put on hold, on the ImageViewer - Link toolbar, click the Hold this page button 📂.

Discard a page during linking

1. In the ImageNow Explorer window, select the batch that contains the page you want to discard.

2. On the File menu, click Open.

3. If the page you want to discard is not displayed first, on the ImageViewer - Link toolbar, click the Hold this page button 📂 until you reach the page you want.

4. On the ImageViewer - Link toolbar, click the Delete this page button 🗑️.

Turn on the Relink icon

1. On the ImageNow toolbar, click the arrow next to Manage and then click Workflow.

2. In the Resource Manager dialog box, in the Workflow tab, select the workflow you want and then click Modify.

3. In the ImageNow Workflow Designer window, double-click the queue in which you want to enable relinking.

4. In the Queue Properties dialog box, click Applets, select the Allow linking from this queue check box and then click OK.


6. Close the Resource Manager dialog box.
Suspend linking a batch

- On the ImageNow Viewer- Link toolbar, click the Suspend Batch button 🔄. The batch is put on hold for later processing. You are returned to the ImageNow Explorer.

  Note To retrieve a suspended batch, open the batch from the ImageNow Explorer.
ImageNow Toolbars

Annotation toolbar

The Annotation toolbar is displayed to users whose roles allow them to add annotations to documents when the active document is one of the following file types: TIFF, JPG, BMP, or PNG.

**Button**  Clicking the button lets you

- Show or hide the annotation layer of the active document.
- Use the mouse pointer to move the document in the window.
- Click on an annotation to modify it.
- Add a stamp image with whatever text and style you define.
- Add a sticky note. The user must double-click the resulting note to display its content.
- Add a text box that can be read without double-clicking.
- Highlight a rectangle in the document.
- Add a check mark anywhere on the document.
- Draw a free-form shape.
- Draw a straight line.
- Draw an arrow.
- Draw a square or rectangle.
- Draw a circle or oval.
Insert objects as annotations using the Microsoft OLE (Object Linking Embedding) technology.

Insert a URL link to a web page.

Insert an opaque rectangle that covers a portion of the document so that the covered information is no longer visible to the viewer.

**ImageNow Explorer toolbar**

The **ImageNow Explorer** toolbar buttons let you perform actions on the items such as batches, documents, or projects that are selected in the grid.

<table>
<thead>
<tr>
<th>Button</th>
<th>Clicking the button lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="ImageNow Viewer" /></td>
<td>Display the selected item in ImageNow Viewer.</td>
</tr>
<tr>
<td><img src="image" alt="Email Format" /></td>
<td>Display the E-mail Format dialog box, which lets you select the way you want to send items to email recipients.</td>
</tr>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Display the Export dialog box, which lets you select the destination folder of the items you are exporting.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Display the Print dialog box, which lets you send the items to your printer.</td>
</tr>
<tr>
<td><img src="image" alt="Document Properties" /></td>
<td>Display the Document Properties dialog box for the selected item.</td>
</tr>
<tr>
<td><img src="image" alt="Document Properties" /></td>
<td>Display the Document Properties dialog box for the selected item. In this dialog box, you can add a note about the document.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refresh the ImageNow Explorer window to display changes that affect either the Views pane or the grid.</td>
</tr>
<tr>
<td><img src="image" alt="Table Control" /></td>
<td>Display the Table Control dialog box, which lets you add columns to or remove columns from the grid.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete the selected items.</td>
</tr>
</tbody>
</table>
ImageNow toolbar
The ImageNow toolbar buttons are your gateway to all ImageNow tasks and features.

- When you click directly on a button, ImageNow starts the activity previously defined as the default for that button.
- When you click on the arrow next to a button, you can select any item in the drop-down list to start its operation.

<table>
<thead>
<tr>
<th>Button</th>
<th>Clicking the button lets you</th>
<th>Clicking the arrow lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="ImageNow Explorer" /></td>
<td>Display ImageNow Explorer for all document batches.</td>
<td>Select all batches, only batches ready for QA or only batches ready for linking.</td>
</tr>
<tr>
<td><img src="image2.png" alt="ImageNow Explorer" /></td>
<td>Display ImageNow Explorer, where you can search for documents.</td>
<td>Select a predefined document query or define a new query.</td>
</tr>
<tr>
<td><img src="image3.png" alt="ImageNow Explorer" /></td>
<td>Display ImageNow Explorer, where you can search for projects.</td>
<td>Define a new query.</td>
</tr>
<tr>
<td><img src="image4.png" alt="ImageNow Explorer" /></td>
<td>Display the ImageNow Explorer for any workflow queues that contain documents.</td>
<td>Select a specific workflow and queue.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Capture Profile" /></td>
<td>Start the default Capture Profile.</td>
<td>Start any Capture Profile in the list.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Help" /></td>
<td>Display online help for the ImageNow product you are currently viewing.</td>
<td>Display online help for any ImageNow product in the list.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Message Center" /></td>
<td>Show or hide the Message Center window.</td>
<td></td>
</tr>
</tbody>
</table>

ImageNow Viewer toolbar
The ImageNow Viewer toolbar buttons let you perform actions on the item that appears in the viewer.

<table>
<thead>
<tr>
<th>Button</th>
<th>Clicking the button lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image8.png" alt="Save" /></td>
<td>Save changes to the item on the ImageNow Server.</td>
</tr>
<tr>
<td><img src="image9.png" alt="E-mail Format" /></td>
<td>Display the E-mail Format dialog box, which lets you select the way you want to send the items to email recipients.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Print" /></td>
<td>Display the Print dialog box, which lets you send the selected document to a printer.</td>
</tr>
</tbody>
</table>
Display the Export dialog box, which lets you select the destination folder of the items you are exporting.

Launch the program associated with the file type of the selected document and open the document in that program.

Display the Document Properties dialog box for the selected item.

Magnify the view one level each time you click it.

Reduce the magnification of the view one level each time you click it.

Rotate the image 90 degrees to the left.

Rotate the image 90 degrees to the right.

Adjust the image to fit the space available in the window.

Adjust the image to fit the width of the window.

Adjust the image to fit the height of the window.

Perform a user-defined task.

Scan one or more pages.

Relink the active document.

Delete the page from the package.
ImageNow Link Viewer toolbar

When linking a batch of pages, you can use one or more of the following toolbar buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Clicking the button lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save button" /></td>
<td>Save the document to the ImageNow Server without closing the page.</td>
</tr>
<tr>
<td><img src="image" alt="E-mail Format button" /></td>
<td>Display the E-mail Format dialog box, which lets you select the way you want to send the selected document to email recipients.</td>
</tr>
<tr>
<td><img src="image" alt="Print button" /></td>
<td>Display the Print dialog box, which lets you send the selected document to a printer.</td>
</tr>
<tr>
<td><img src="image" alt="Export button" /></td>
<td>Display the Export dialog box, which lets you select the destination folder of the items you are exporting.</td>
</tr>
<tr>
<td><img src="image" alt="Launch Program button" /></td>
<td>Launch the program associated with the file type of the selected document and open the document in that program.</td>
</tr>
<tr>
<td><img src="image" alt="Document Properties button" /></td>
<td>Display the Document Properties dialog box for the document selected in the associated applet.</td>
</tr>
<tr>
<td><img src="image" alt="Magnify button" /></td>
<td>Magnify the view one level each time you click it.</td>
</tr>
<tr>
<td><img src="image" alt="Reduce Magnification button" /></td>
<td>Reduce the magnification of the view one level each time you click it.</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Left button" /></td>
<td>Rotate the image 90 degrees to the left.</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Right button" /></td>
<td>Rotate the image 90 degrees to the right.</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Space button" /></td>
<td>Adjust the image to fit the space available in the window.</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Width button" /></td>
<td>Adjust the image to fit the width of the window.</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Height button" /></td>
<td>Adjust the image to fit the height of the window.</td>
</tr>
<tr>
<td><img src="image" alt="DocKey Replacement button" /></td>
<td>Replace the DocKey values (for example, Drawer and Folder) in the applet’s current document with the corresponding values from the record selected in the host program.</td>
</tr>
</tbody>
</table>
Save the selected batch page to the ImageNow Server and close the page.

Skip the page but keep it in the batch for later linking.

Suspend the linking process and return to ImageNow Explorer.

Delete the page from the batch.

**ImageNow PackageViewer toolbar**

When scanning a package of pages for a document, you can use the toolbar buttons to adjust the image and perform various tasks before submitting the pages to the ImageNow Server.

**Button**  |  **Clicking the button lets you**
---|---
Display the Document Properties dialog box for the document selected in the associated applet.  |  Magnify the view one level each time you click it.  
Reduce the magnification of the view one level each time you click it.  |  Rotate the image 90 degrees to the left.  
Rotate the image 90 degrees to the right.  |  Adjust the image to fit the space available in the window.  
Adjust the image to fit the width of the window.  |  Adjust the image to fit the height of the window.  
Scan one or more pages.  |  Submit the pages in the package to the ImageNow Server.
Replace the DocKey values (for example, Drawer and Folder) in the applet’s current document with the corresponding values from the record selected in the host program.

Delete the page from the package.

**ImageNow Project Viewer toolbar**

The **ImageNow Project Viewer** toolbar buttons let you perform actions on the documents that have been added to a project.

**Button** | **Clicking the button lets you**
---|---
![ImageNow Viewer icon](image_now_viewer_icon.png) | Display the selected document in the ImageNow Viewer.

![Email Format icon](email_format_icon.png) | Display the E-mail Format dialog box, which lets you select the way you want to send the documents to email recipients.

![Export icon](export_icon.png) | Display the Export dialog box, which lets you select the destination folder of the documents you are exporting.

![Print icon](print_icon.png) | Display the Print dialog box, which lets you send the document to your printer.


![Document Properties icon](document_properties_icon.png) | Display the Document Properties dialog box for the selected document. When you select Document on the left panel, then on the Document Keys tab, you can add a note about the document.

![Refresh ImageNow Explorer icon](refresh_image_now_explorer_icon.png) | Refresh ImageNow Explorer to display changes that affect either the Views pane or the grid.

![Table Control icon](table_control_icon.png) | Display the Table Control dialog box, which lets you add columns to or remove columns from the grid.

![Delete icon](delete_icon.png) | Delete the selected documents from the ImageNow Server.

**Note** To remove the document from the project, in the left pane, click the **Remove this document from a project** button.

**Image Now QA Viewer toolbar**

When you QA a batch of pages, you can use one or more of the following toolbar buttons.

---

28
<table>
<thead>
<tr>
<th>Button</th>
<th>Clicking the button lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Print]</td>
<td>Display the Print dialog box, which lets you send the selected documents to a printer.</td>
</tr>
<tr>
<td>![Export]</td>
<td>Display the Export dialog box, which lets you select the destination folder of the items you are exporting.</td>
</tr>
<tr>
<td>![Launch]</td>
<td>Launch the program associated with the file type of the selected document and open the document in that program.</td>
</tr>
<tr>
<td>![Magnify]</td>
<td>Magnify the view one level each time you click it.</td>
</tr>
<tr>
<td>![Reduce Magnification]</td>
<td>Reduce the magnification of the view one level each time you click it.</td>
</tr>
<tr>
<td>![Rotate Left]</td>
<td>Rotate the image 90 degrees to the left.</td>
</tr>
<tr>
<td>![Rotate Right]</td>
<td>Rotate the image 90 degrees to the right.</td>
</tr>
<tr>
<td>![Adjust Fit]</td>
<td>Adjust the image to fit the space available in the window.</td>
</tr>
<tr>
<td>![Adjust Width]</td>
<td>Adjust the image to fit the width of the window.</td>
</tr>
<tr>
<td>![Adjust Height]</td>
<td>Adjust the image to fit the height of the window.</td>
</tr>
<tr>
<td>![Accept]</td>
<td>Mark the page as acceptable and move to the next page in the batch.</td>
</tr>
<tr>
<td>![Scan]</td>
<td>Scan the page again and replace the active page with the scanner output.</td>
</tr>
<tr>
<td>![Send]</td>
<td>Send all pages in the batch to the ImageNow Server and exit the QA Viewer. The status of the batch is Complete.</td>
</tr>
<tr>
<td>![Suspend]</td>
<td>Suspend QA activity and exit the QA Viewer. The status of the batch is Suspended.</td>
</tr>
<tr>
<td>![Remove]</td>
<td>Remove the active page from the batch. This page is not sent to the server with the other pages.</td>
</tr>
</tbody>
</table>
Version Control toolbar

If you are using ImageNow Version Control, you can use the following buttons in ImageNow Explorer in various modes. The buttons are available for items that are in Version Control.

<table>
<thead>
<tr>
<th>Button</th>
<th>Clicking the button lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Lock Icon" /></td>
<td>Check the item into Version Control.</td>
</tr>
<tr>
<td><img src="image" alt="Unlock Icon" /></td>
<td>Check the item out of Version Control.</td>
</tr>
<tr>
<td><img src="image" alt="Unlock Icon" /></td>
<td>Cancel the check-out of an item from Version Control.</td>
</tr>
<tr>
<td><img src="image" alt="Document Properties Icon" /></td>
<td>Display the Document Properties dialog box with a Version History item in the left pane.</td>
</tr>
<tr>
<td><img src="image" alt="Garbage Icon" /></td>
<td>Remove the selected item from Version Control.</td>
</tr>
</tbody>
</table>

ImageNow Workflow Viewer toolbar

When processing documents or projects through workflow queues, you can use the following buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Clicking the button lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Icon" /></td>
<td>Save the document to the ImageNow Server without closing the page.</td>
</tr>
<tr>
<td><img src="image" alt="E-mail Format Icon" /></td>
<td>Display the E-mail Format dialog box, which lets you select the way you want to send the selected document to email recipients.</td>
</tr>
<tr>
<td><img src="image" alt="Print Icon" /></td>
<td>Display the Print dialog box, which lets you send the selected documents to a printer.</td>
</tr>
<tr>
<td><img src="image" alt="Export Icon" /></td>
<td>Display the Export dialog box, which lets you select the destination folder of the items you are exporting.</td>
</tr>
<tr>
<td><img src="image" alt="Launch Icon" /></td>
<td>Launch the program associated with the file type of the selected document and open the document in that program.</td>
</tr>
</tbody>
</table>
Display the Document Properties dialog box for the document selected in the associated applet.

Start a user-defined action.

Display the next item in the queue.

Send the item back to any queue in which it resided previously.

Send the item back to the previous queue in which it resided.

Send the item to the next queue in the workflow.

Send the item to any queue in the workflow.

Recall the item from the queue to which it was just routed if the time-out interval has not expired. If the time-out interval has expired for the item, the button is dimmed.

Mark the item as on hold and hides the item from all users but the owner.

Mark the item as pending, which allows other authorized users to open and route the item.

Archive the item.

Remove the item from the workflow. This does not delete the item from the ImageNow server.

Display workflow history.

Display a list of recently routed items.
Setting ImageNow Options

Customize your ImageNow toolbar
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. In the General tab, under Toolbar, do the following:
   • To change the theme of the toolbar, in the Theme list, select ImageNow, Office 2003, or Windows.
   • To increase or decrease the toolbar’s icon size, in the Icon size list, select Small, Medium, Large, or Extra Large.
   • To show or hide the menu bar, in the Menu bar list, select On or Off.
   • To show or hide the toolbar’s button captions, in the Button text list, select On or Off.
   • To show or hide the drop-down lists next to the buttons, in the Split buttons list, select On or Off.
3. In the Defaults tab, in the Default mode list, choose Expanded to expand the toolbar to display all buttons or Condensed to consolidate Applets, Batches, Documents, Projects, and Workflow buttons to a single View button.
4. Click OK.

Show or hide the ImageNow menu bar
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. In the General tab, under Toolbar, in the Menu bar list, select one of the following:
   • On to show the menu bar.
   • Off to hide the menu bar.
3. Click OK.

Set default ImageNow feature options
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. In the Defaults tab, under General, do the following:
   • In the Applets list, select the default applet.
   • In the Batches list, select the default batch.
   • In the Capture list, select the default Capture profile.
   • In the Documents list, select the default search query.
   • In the Help list, select the default Help module.
   • In the Manage list, select default managed object.
   • In the Project list, select the default project.
   • In the Workflow list, select the default workflow queue.
3. Click OK.
Change Message Center options
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. On the Message Center tab, under General, do the following:
   - In the Default mode list, select Expanded to show the Message Center window when ImageNow is started or select Compact to prevent the Message Center window from displaying when ImageNow is started.
   - To change the size of the Message Center window, in the Window size list, select Small, Medium, or Large.
   - To show the Message Center window moving downward as it opens, in the Animation style list, select Scroll, or to disable this scroll, select None.
3. Under Marquee, you can modify the horizontal strip below the toolbar as follows:
   - In the Font color list, select the color you want.
   - In the Scroll rate box, type a number from 1 to 50 (fastest) to change the speed of the window as it descends below the marquee.
4. Under Workflow Queue Status, to designate which workflow queues display in the Message Center window, select the corresponding check boxes in the list.
5. Click OK.

Change your version control folder
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. If you are using ImageNow Version Control, in the General tab, under Version Control, click Browse, navigate to select the folder where ImageNow will save managed documents on your local computer, select the folder, and then click OK.
3. Click OK.

Change e-mail options
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. On the E-mail tab, under WebNow Link Options, select the Include URL attachment in e-mail check box to allow a URL to be attached to e-mail or clear the check box to prevent a URL from being attached to e-mail.
3. If your computer doesn't have an e-mail program (such as MS Outlook or Lotus Notes), in the E-mail tab, under SMTP, select the Send e-mail via SMTP check box, and then select from the following:
   - Select the Send return message to sender on success check box to send a message to the sender if the e-mail is delivered successfully.
   - Select the Send return message to sender on failure check box to send a message to the sender if the e-mail is not delivered successfully.
   - In the Sender's e-mail address box, type the address to which the return messages are sent.
4. Click OK.
Note When you opt to send e-mail via SMTP, as in step 3 above, you must complete the configuration from ImageNow Viewer. This is a one-time procedure per workstation. After you have closed the Options dialog box, open any document in the ImageNow Viewer, click the E-mail button in the toolbar, choose the option you want in the E-mail Format dialog box, and then click OK. In the ImageNow dialog box that appears next, enter the name or IP address of the SMTP server that your organization is using and then click OK. You may need to ask your ImageNow administrator for this information.

Change Date and Time format
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. On the General tab, under Date and Time, select the Use regional settings when displaying date and time fields check box to change from the ImageNow date format to the date format used by your computer. Clear this checkbox to use the ImageNow date format.
3. If you are using regional date and time settings, select the Include time stamp check box to add a time stamp to the right of the date.
4. Click OK.

Change your ImageNow System Tray settings
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. In the System Tray tab, under General, select the Enable System Tray icon check box to show the icon in the system tray, or clear the check box to disable the system tray icon.
3. In the following lists, select the action that results from the mouse or key combination. These actions include launching the ImageNowToolbar, or displaying the default for Applets, Batches, Documents, Projects, Workflow, Capture, Manage, or Help.
   - On mouse click
   - On Ctrl-click
   - On Alt-click
4. Click OK.
Tip
You can also right-click the ImageNow tray icon to display the ImageNow tray icon and other shortcuts.

Disable the ImageNow System Tray icon
1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. On the System Tray tab, under General, clear the Enable System Tray icon check box.
3. Click OK.
Tip
You can also disable the icon from the system tray by right-clicking it and selecting Remove Tray Icon.
Set LearnMode options

Contact your ImageNow Owner or Manager for information about the overall effect of these settings. Refer to the ImageNow Administrator Help file for more information. Modifying these settings incorrectly could make your applets stop working.
Basic Tasks

Customize ImageNow Explorer

1. In the ImageNow Explorer window, on the File menu, click Options.
2. In the Explorer Options dialog box, you can choose to set any of the following options:
   
   - **To change the preset search options**
     - On the Search tab, you can change the following options:
       - To display more search options, in the Default search method list, select Advanced, or select Simple to display fewer search options.
       - To preset the search operator, in the Default search operation list, select an operator.
       - To constrain the documents returned by a search to a specific time period, in the Default time constraint (days) list, type or select the number of days.
       - To limit the number of rows returned by a search, in the Maximum number of results box, type the maximum number of rows.
   
   - **To change the appearance of grids**
     - On the Grid Options tab, select the font, size, style, color, and line values that you want.
     - To change column headings in the Explorer grid, on the Column Headings tab, under General, under Select the criteria for the default column headings, do the following:
       - To copy headings from an applet, click Use column headings from applet, click the arrow, and then select the applet you want.
       - To create your own column headings, click Use custom column headings, and then type your replacement headings in each of the boxes below.
     - To change the grid lines and text, on the Grid Options tab, select the font, size, style, color, and line values that you want.
     - To change column headings, on the Column Headings tab, do the following:
       - To copy headings from an applet, click Use column headings from applet, and then select the applet you want from the list.
       - To create your own column headings, click Use custom column headings, and then type your replacement column headings in Drawer, Folder, Tab, F3, F4, F5, and Document Type.
   
   - **To change batch processing options**
     - On the Batch tab, under General, do the following:
       - To display fewer pages when you QA a batch, in the During QA, review list, select first page only, first and last page, or last page only.
       - To display a message asking you to confirm any time you discard a page, select the Confirm page discards check box.
     - Under Link Groups, do the following:
       - To link a fixed number of pages to the same record in the selected applet, click Custom Size box, and then type the number of pages you want to link to the same record.
• To link all pages in the batch to the same record in the selected applet, select **All pages in batch**. With this selection, you can select one or both of the following options:
  
  • To cause ImageNow to display a message asking you to confirm linking all pages to the same record, select the **Prompt user for verification** check box.
  
  • To perform the linking on the ImageNow Server (which speeds performance), select the **Invoke server-side processing** check box or clear the check box if you want to route processing through your ImageNow Client computer.

• **To change the way workflow starts up**
  
  • On the **Workflow** tab, under **Workflow Startup**, in the **On workflow start** list, select one of the following:
    
    • To open the oldest item in the queue, select **Retrieve an item to be processed in viewer**.
    
    • To display a list of all items in the queue, select **Show list of all items in work queue**.
    
    • To display your current pending items list, select **Show list of all items placed on hold by current user**.
    
    • To open the first item in the queue list based on the sort order, select **Retrieve an item to be processed from Workflow**.

• **To change the way items are fetched in workflow**
  
  • On the **Workflow** tab, under **Workflow Processing**, do the following:
    
    • To designate the item that is fetched next, in the **When fetching next item, get** list, and then select **Next item in Workflow Grid**, **Oldest item in Queue**, or **Next item from top of Workflow Grid**.
    
    • To fetch the next item automatically, select the **Auto fetch new item upon completion of existing item** check box or clear the check box to turn off automatic fetching.
    
    • To fetch pending items, click the **Allow pending items to be auto fetched for processing** check box or clear the check box to designate not to fetch pending items.

• **To change the way a workflow session closes**
  
  • On the **Workflow** tab, under **Workflow Closing**, in the **On workflow session cancel or close** list, choose one of the following:
    
    • To place the current item on hold, select **Put active item on hold**.
    
    • To return the item to the queue, select **Return active item to existing Queue**.
    
    • To display a dialog box prompting you to put the item on hold or return it to the queue, select **Prompt user for choice**.
    
    • To change the way DocKeys are saved as you exit, in the **Save changes to document keys** list, choose **Yes**, **No**, or **Prompt**.

• **To change the workflow session alerts**
  
  • To cause ImageNow to notify you when an item has been sitting in a Workflow Queue too long, on the **Workflow** tab, under **Alerts**, in the **Alert user when item is older than** boxes, select the number and the time unit (days, weeks, hours, or minutes) that you want.

3. Click **OK**.
Customize ImageNow Viewer

1. In ImageNow Viewer, on the File menu, click Options.
2. On the General tab, under General, you can choose to do any of the following tasks:
   • Under General, in the Automatically tile pages list, select Enabled to turn on tiling or select Disabled to turn it off.
   • In the Grayscale images list, select Enabled to turn on smoothing of images or select Disabled to turn it off.
   • To change the fitting of an image to its window, in the Default image size list, select Fit Window, Fit Height, or Fit Width.
3. Under Launching, you can choose to open a new Viewer window in the following circumstances:
   • When opening a document from ImageNow Explorer, select the ImageNow Explorer check box.
   • When opening a document from ImageNow Project Viewer, select the ImageNow Project Viewer check box.
   • When selecting the Next and Previous document buttons, select the Next/Previous document buttons in the ImageNow Viewer check box.
4. Under Text File, to designate how the ImageNow Viewer displays text files (such as ASCII) with no built-in formatting, in the Font type list, select the font and then in the Font size box, select the font size.
5. On the Page Fetching tab, you can do the following:
   • To limit the number of pages the ImageNow Viewer can have open at the same time, under General, select the Limit the number of open pages check box, and then select the number of pages.
   • To designate the number of pages that are fetched from the ImageNow Server when opening a document, under Page Prefetch, in the Number of pages to retrieve when opening list, select the number you want.
6. Click OK.

Capture a document

This topic assumes that your capture and scanning profiles are set up and ready to use.

1. Verify that the capture profile you want to use is set by default:
   • Click the down arrow next to Capture on the ImageNow toolbar, and then right-click the profile you want to set by default.
   • On the shortcut menu, click Set as Default Action.
2. On the ImageNow toolbar, click Capture.
3. Scan documents using your scanner or navigate to the images on your computer to import.
4. Click OK.
Capture a package of documents

This topic assumes that your package-mode capture profile, Basket Group and Baskets, and Document Rules (if any) are set up and ready to use.

1. In your host application, display the information or account record for the customer, such as a patient or student, who is submitting a set of documents to you for scanning.

2. On the ImageNow toolbar, click the arrow next to Applets and make sure the applet that was defined for your host application is selected in the list.

3. On the ImageNow toolbar, click the arrow next to Capture and then click Package Mode.

4. If Scan Prompter does not appear, skip to step 6.

5. When the ImageNow Viewer appears, follow the instructions on Scan Prompter for each affected document and then skip to step 7.
   - If a Scan button is displayed for a document and other buttons are dimmed, insert the customer's document and click Scan in the corresponding row in Scan Prompter.
   - If a Review button is displayed and the Defer button is dimmed, click the Review button in the corresponding row in Scan Prompter to inspect the document that was previously scanned into ImageNow.
   - If a Defer button is displayed with the Scan and Review buttons, you can optionally click Defer to continue to the next row in Scan Prompter.

6. Insert the customer's documents in the scanner and click the Scan button in the toolbar.

   Note  If additional Capture Profiles are displayed in the list to the left of the Scan button, you can select one of those to switch from the currently selected Capture Profile. The next time you scan, ImageNow will use the profile you selected.

   ImageNow displays the documents as page icons in the designated receiving Basket in the ImageNow Viewer window.

7. As necessary, drag the documents from the receiving Basket into the other Baskets in the Basket Group tree.

8. If you need to enter additional DocKey values for any of the documents, double-click the document in its Basket and make the changes.

9. When all documents have been satisfactorily scanned and updated, click the Submit button.

   This completes the package scanning session.

Print a document

1. From the ImageNow Explorer, select the document or set of documents you want to print.

2. On the File menu, click Print.

3. In your Print dialog box, print documents as you normally would.
Import a document using ImageNow Printer

1. Open the document you want to import into ImageNow, click **File**, and then click **Print**.
2. Set the printer name to **ImageNow Printer**, and then click **OK**.
   
   **Note** If you have more than one ImageNow Printer Capture Profile set up, the **ImageNow Print** dialog box appears. From the **CaptureNow Profile** list, click the ImageNow Printer profile you want, and then click **OK**. CaptureNow "prints" the document into ImageNow.

3. In the **ImageNow Viewer- Scan Mode** window, verify image quality and make any changes you want using the options available to you in ImageNow Viewer.

Email a document

1. In the **ImageNow Explorer**, select the document you want to email.
2. On the **File** menu, click **E-mail**.
3. In the **E-mail Format** dialog box, choose the option you want and then send the email as you normally would.

   **Note** To send e-mail, ImageNow uses the default e-mail program that you have configured on your system.

Export a document

1. From the **ImageNow Explorer**, select the document or set of documents you want to export.
2. On the **File** menu, click **Export**.
3. In the **Export** dialog box, select your method for exporting documents and whether you want to include any annotations, and then click **OK**.

Search for a document

1. On the **ImageNow** toolbar, click **Documents**.
2. In the **ImageNow Explorer**, on the **Simple** search tab, set the **Search** lists and field to the criteria you need to retrieve your document, and then click **Search**.
3. From the search results, double-click the document you want. It will open in the **ImageNow Viewer**.
Dock task panes in another position

- From any view where there is a task pane in ImageNow, you do one or all of the following:
  - Double-click a task pane and it will undock. If it is undocked and you double-click it, it will dock in place.
  - Click and drag a task pane from its original position. Docking arrows will appear. If you drag a task pane to an arrow and highlight it, you can preview the new docking position. When you release the mouse while a docking arrow is selected, then it will assume the new position.
  - Click and drag a task pane from its original position, and if you release the mouse in the absence of no docking arrows, then the pane will assume the position it is currently in on your workspace.

Turn on the Message Center

1. On the ImageNow toolbar, click the Settings menu, and then click Options.
2. On the Message Center tab, under General, in the Default mode list, select Expanded.
3. Click OK.
About searching for a document

Using ImageNow, you can perform a simple search with one condition or you can perform a more advanced search with multiple conditions. These features are available in the Document View of the ImageNow Explorer with the proper search privileges. You must have simple or advanced search privileges to perform either of these types of searches. In addition, if you installed the Content Server agent, which is available as a separate add-on, you can perform full-text searches on your ImageNow documents.

In a simple search, you can query for documents that contain a DocKey, like Drawer, Folder, Tab, Field 3, Field 4, Field 5, or Document Type, or a custom property that matches a condition you supply. Available conditions in a simple search include: is equal to, is not equal to, is greater than, is less than, is greater than or equal to, and is less than or equal to. For example, you can search for all documents linked to Accounts Payable account number 502, all documents of a particular document type, like Invoices, or all documents that contain a custom property that matches the comparison value you supply.

In an advanced search, you can search for documents that meet several different criteria with additional operators, such as contains, does not contain, is null, is not null, starts with, ends with, is not equal, and so on. In addition to searching for DocKey comparisons, in advanced search, you can search for specific document properties, including document version; a specified user who created, checked out, modified, or was the last to view the document; the date of check out, creation, modification, and last view; and the workflow queue, status, user, and item ID. Document status is another category on which you can query to find documents that are in workflow, in a project, version controlled, or checked-out. You can also search all fields for a specific condition. To search for several conditions, separate each condition with an AND or OR operator. Using an advanced search, you can also specify how you want the resulting documents sorted.

As part of the advanced search, when the Content Server is installed, you can perform full-text or natural language queries. Full text queries can include a variety of operators, including: all, and, any, or, near, paragraph, phrase, sentence, and many more. In a natural language query, you can use the freetext and like operators. For a context search, the Content Server agent collects text data (gathered via OCR for scanned images) and creates searchable indexes based on the content of each document page.

Content search enables you to search the content of scanned images and more than 200 popular document formats, including Microsoft Word, Microsoft Excel, WordPerfect, and HTML. Content Server can also gather this information from PDF files.

Search by an index key (Simple)

1. In the ImageNow Explorer, verify that the Views pane is displayed.
   
   How?
   
   • On the ImageNow Explorer toolbar, click the View menu, and then point to Views.

2. In the Views pane, select Documents.
3. On the Simple tab, in the Filter where list, choose one of the following methods:
   - Select the DocKey you want to search, including Drawer, Folder, Tab, Field 3, Field 4, Field 5, or Document Type.
   - Select ANY DocKey.
   - Select Custom Property. In the Custom Properties dialog box, in Document Type, select a document type to filter the displayed custom properties, under Property Name, select a property, and then click Select.

4. To supply the remainder of the search criteria, select an operator, and then type text in the field to compare your criteria.

5. To limit the search to a certain time period, type or select the number of days you want the search to encompass in and created in last <number> days. You can also select any to return all matching documents without a time limitation.

6. Click Go.

Search using multiple index keys (Advanced)

1. In the ImageNow Explorer, verify that the Views pane is displayed.
   
   How?
   
   - On the ImageNow Explorer toolbar, click the View menu, and then point to Views.

2. In the Views pane, select Documents.

3. In the Search area, on the Advanced tab, click Add.

4. In the Add Condition dialog box, make the following changes, and then click OK.
   
   - In Condition, select By Document Keys, By Document Properties, By Document Status, or By All Fields.
   - In Field, provide the search criteria, based on the selected search condition.
     - For a document key search, select a document key.
     - For a document property search, search on any of the properties fields, like Pages or Creation Date.
     - For a document status search, select from Is in Workflow, Is in a Project, Is Version Controlled, and Is Checked-out.
     - For an all fields search, select any of the document key, property, or status options.
   - In Operator, select a comparison operator, such as Equals, Less than, or LIKE.
   - In Type, select Normal or Prompted. If you select Prompted, when the search is performed, a Prompt Conditions dialog box appears requesting you to enter any missing comparison values.
   - In Value, type or select the value to which you want the field compared.

5. Optional. Click Add to add another condition. ImageNow places an AND between the two conditions. You can manually change the AND to OR as needed.

6. Optional. To sort the returned documents, click Sorting. In the Sorting dialog box, do the following:
   
   - In Available Fields, select a field and then click Add.
   - In Sort By, select the field and choose Ascending or Descending.
   - Add additional fields as needed.
   - When you are finished, click OK.
7. To limit the search to a certain time period, select the number of days you want the search to encompass in and created in last <number> days. You can also select any to return all matching documents without a time limitation. Also, if you add a constraint that uses the Creation Date field in your query, this option is automatically set to any.

8. Click Go.

Create a search query
1. In the ImageNow Explorer, verify that the Views pane is displayed.
   How?
   • On the ImageNow Explorer toolbar, click the View menu, and then point to Views.
2. In the Views pane, click Documents.
3. In the Documents grid, on any search tab, create the query you want to save.
4. In the ImageNow Explorer toolbar, in the query list, click Save Query.
5. In the Save Query dialog box, in the Name box, type a name for your query.
6. Under Type, click Local or Server.
7. Click OK.

Run a stored search query
In the query list, the saved queries are grouped by Local and Server. Your privileges determine the queries that appear in this list.

1. In the ImageNow Explorer, verify that the Views pane is displayed.
   How?
   • On the ImageNow Explorer toolbar, click the View menu, and then point to Views.
2. In the Views pane, click Documents.
3. In the ImageNow Explorer, in the query list on the toolbar, select the query you want to run.
Rename a saved query

1. In the ImageNow Explorer, verify that the Views pane is displayed.
   How?
   • On the ImageNow Explorer toolbar, click the View menu, and then point to Views.
2. In the Views pane, click Documents.
3. In the ImageNow Explorer, click the query list on the toolbar, and then select Edit Query List.
4. In the Edit Query List dialog box, click the Local Queries or Server Queries tab, and then select a query, and then click Rename.
5. In the Rename Query dialog box, in Enter new name, type a new name for the query, and then click OK.
6. Click Close.

Delete a query

1. In the ImageNow Explorer, verify that the Views pane is displayed.
   How?
   • On the ImageNow Explorer toolbar, click the View menu, and then point to Views.
2. In the Views pane, click Documents.
3. In the ImageNow Explorer, click the query list on the toolbar, and then select Edit Query List.
4. In the Edit Query List dialog box, click the Local Queries or Server Queries tab, and then select a query, and then click Remove.
5. To confirm that you want to delete the query, click Yes.
6. Click Close.

Set search options

1. On the ImageNow Explorer toolbar, click File, and then click Options.
2. On the Explorer Options dialog box, on the Search tab, set the following options:
   • In the Default search method list, select Simple or Advanced.
   • In the Default search operator list, select a default operator for searches.
   • In the Default time constraint (days), type or select the default number of days you want the search to encompass.
   • In the Number of results to return list, type or select the maximum of rows that are returned by the query. This number must be between 100 and 25,000.
3. Click OK.
Content Search

Search the content of documents (Simple)

You must have the ImageNow Content Server installed and running before you can search the content of documents. When the Content Server is available, in the Search area of ImageNow Explorer, in the Simple tab, the Filter where field displays a Full Text option. In a simple content search, an "accrue" search occurs based on the search values you provide to locate documents that contain one or more of the search values. You can also perform a more complex content search using the Advanced tab.

1. In the ImageNow Explorer, in the Views pane, select Documents.
2. In the Search area, on the Simple tab, in Filter where, select Full Text.
3. In the search field, type the text for which you want to search. To search for multiple values, separate the text with commas (term1, term2). When you supply mixed case characters in your search values, such as "Resume", the Content Server locates documents that contain the case-sensitive value. For example, "Resume" locates only "Resume" and not "resume". If you supply the same value using characters in the same case, you indicate case-insensitivity. In this case, "resume" locates "Resume", "RESUME", and "resume".
4. To limit the search to a certain time period, select the number of days you want the search to encompass in and created in last <number> days. You can also select any to return all matching documents without a time limitation. Also, if you add a constraint that uses the Creation Date field in your query, this option is automatically set to any.
5. Click Go.

Note The results of the search appear in the Search grid, which displays a Score and a Details column. The Score column shows the numeric relevance ranking of each document. The Details column lists each word that was found and, in parenthesis, the frequency in which it was found (for example, account(2), accounts(1)). The results of the search appear in relevance order, with the highest Score at the top of the grid.

Search the content of documents (Advanced)

You must have the ImageNow Content Server installed and running before you can search the content of documents. When the Content Server is available, in the Search area of ImageNow Explorer, the Advanced tab contains an additional and content field below the Filter where field, as shown by the following figure. In the Advanced tab, you can search for documents with specific DocKeys or properties (in the Filter where field) in addition to the content keywords (in the and content field).

1. In the ImageNow Explorer, in the Views pane, select Documents.
2. In the Search area, perform one of the following tasks:
   - On the Advanced tab, in and content, type the text for which you want to search. To search for multiple terms, separate the text with commas (term1, term2).
On the **Advanced** tab, click **Add** and then perform the following tasks:

1. In the **Add Condition** dialog box, in **Condition**, select **By Content**.
2. In **Type**, click one of the following search options and perform the associated steps:
   - **Full Text** to search content for individual words.
     1. In **Value**, type the text for which you want to search. To search for multiple terms, separate the text with commas (term1, term2). When you supply mixed case characters in your value, such as "Resume", the Content Server locates documents that contain the case-sensitive value. For example, "Resume" locates only "Resume" and not "resume". If you supply the same value using characters in the same case, you indicate case-insensitivity. In this case, "resume" locates "Resume", "RESUME", and "resume".
     2. Click **Add Quotes** to add quotation marks added to the text in **Value**. This changes the search from a "stem" search of the text (if you enter account, the search returns items that stem from account, like accounts and accountable) to a search for the literal text (if you enter account, only the word account is in the result set).
     3. In **Operator**, select the operator you want to use to define your query from the following list. Documents retrieved using ACCRUE, ALL, AND, Any, or OR operators are ranked in relevance by the Content Server from 1.00 to 0.00, with 1.0 being the most relevant.
       - **ACCRUE** selects documents that include at least one of the search values. The relevance-ranking of a document is related to the number of instances of the search values found in the document. The higher number of search values found in the document, the higher the relevance score.
       - **ALL** selects documents that contain all of the search values. All retrieved documents are assigned a score of 1.00.
       - **AND** selects documents that contain all of the search values. All retrieved documents are ranked for relevance, where the documents are assigned a score between 0.00 and 1.00.
       - **ANY** selects documents that contain at least one of the search values. All retrieved documents are assigned a score of 1.00.
       - **OR** selects documents that contain at least one of the search values. All retrieved documents are ranked for relevance, where the documents are assigned a score between 0.00 and 1.00.
       - **NEAR** selects documents that contain the search values. The closer the search terms are located in proximity within a document, the higher the document's score.
       - **PARAGRAPH** selects documents that include all of the search values within the same paragraph.
       - **PHRASE** selects documents that include the phrase you specify in the search value. A phrase is a grouping of two or more words that occur in a specific order.
       - **SENTENCE** selects documents that include all of the search value words within the same sentence.
4. For Evidence, select one of the following evidence operators:
   - **SOUNDEX** expands the search to include the word you enter and one or more words that "sound like," or whose letter pattern is similar to, the word specified. Collections do not have sound-alike indexes by default; you must build the sound-alike indexes to use this feature.
   - **STEM** expands the search to include the word you enter and its variations.
   - **THESAURUS** expands the search to include the word you enter and its synonyms.
• **TYPO** expands the search to include the word you enter and words similar to the query term. This operator performs "approximate pattern matching" to identify similar words.

• **WILDCARD** matches wildcard specific characters in search strings. For example, you can use the following wildcards:
  - An asterisk specifies 0 or more alphanumeric characters (where corp* locates corps and corporation).
  - A question mark specifies one alphanumeric character (where m?n locates "man" and "men", but not "main").
  - A set of square brackets specifies one of any characters in a set (where c[auo]t locates "cat", "cut", and "cot"). A carat in a set of square brackets specifies one character not in the set (where c[^au]t excludes "cat" and "cut", but locates "cot"). A hyphen in a set of square brackets specifies a range of characters (where c[a-r]t locates every three-letter word from "cat" to "crt").
  - A set of braces specifies one of a pattern (where bank{s,er,ing} locates "banks", "banker", and "banking").

• **WORD** performs a basic word search and selects documents that include one or more instances of the specific word you enter.

5. Depending on your selections for Operator and Evidence, you can select additional modifiers you want to use to define your query.

• **Exclude matching values (NOT)** excludes matching values.

• **Consider document density in scoring (MANY)** considers document density in scoring.

• **Match case of entire word or phrase (CASE)** matches the case of the entire word or phrase.

• **Match values in specified order (ORDER)** matches values in specified order.

You can use **Natural Language** to specify search criteria using natural language syntax.

1. In **Value**, type the text for which you want to search. To search for multiple terms, separate the text with commas (term1, term2). When you supply mixed case characters in your value, such as "Resume", the Content Server locates documents that contain the case-sensitive value. For example, "Resume" locates only "Resume" and not "resume". If you supply the same value using characters in the same case, you indicate case-insensitivity. In this case, "resume" locates "Resume", "RESUME", and "resume".

2. In **Operator**, select the operator you want to use to define your query from the following list:
  - **FREETEXT** interprets text using the free text query parser, and scores documents using the resulting query expression. All retrieved documents are relevance-ranked.
  - **LIKE** searches for other documents that are like the sample one or more documents or text passages you provide. The search engine analyzes the provided text to find the most important terms to use for the search. Retrieved documents are relevance-ranked.

3. Click **Exclude matching values (NOT)** to exclude matching values.

4. Click **OK**.

3. Optional. Click **Add** to provide additional conditions. ImageNow places an AND between the two conditions. You can manually change the AND to OR as needed.
4. Optional. Click **Sorting** to sort the results. In the **Sorting** dialog box, choose the fields on which to sort, choose **Ascending** or **Descending**, and then click **OK**.

5. To limit the search to a certain time period, select the number of days you want the search to encompass in **and created in last <number> days**. You can also select **any** to return all matching documents without a time limitation. Also, if you add a constraint that uses the **Creation Date** field in your query, this option is automatically set to **any**.

6. Click **Go**.

   **Note** The results of the search appear in the Search grid, which displays a Score and a Details column. The Score column shows the numeric relevance ranking of each document. The Details column lists each word that was found and, in parenthesis, the frequency in which it was found (for example, account(2), accounts(1)). The results of the search appear in relevance order, with the highest Score at the top of the grid.

### Change content search highlight color

1. Using Windows Explorer, navigate to the [drive:]\Program Files\ImageNow6\ folder and open the **imagenow.ini** file in a text editor.

2. Scroll down to the **[FullText]** header.

3. For the **Highlights** setting, type an RGB color value to customize the highlight color, as shown in the following example:

   ```plaintext
   [FullText]
   Highlights=RGB(255,0,0)
   ```

4. Save and close the **imagenow.ini** file.
Annotations

What is an annotation?
You use an annotation in ImageNow to mark up and comment on a document without affecting the original image. You can position annotations where you need in the document. ImageNow offers many types of annotations so you can express the different points you want to make. For example, in ImageNow, you can express your review of a document by stamping it approved, signing off on it using a pen, or adding a check mark. You can also add sticky notes to add small notes to a document object, either inline or as a global comment on the document. You can add annotations on the following file types: TIFF, JPG, BMP, and PNG files.

Each ImageNow annotation requires an annotation template that is created and customized for any supported annotation type. Security options are also available based on the template. For example, you can create a Stamp template with the following text: "Received by Accounts Payable". Your ImageNow administrator can set the template security so that only users in the Accounts Payable group can use, modify, or delete annotations created using that Stamp template. If your ImageNow administrator does not grant ImageNow users in the Human Resources access to view stamps created using that stamp template, those users cannot view, modify, or delete this annotation.

A redact is a solid graphic that covers a portion of an image or document so that the covered information is no longer visible to the viewer. This redaction enables you to alter the document, or a copy of the document, and permanently remove legally significant information. Additionally, when you add a redact annotation, you retain the original while creating a redacted copy for users. Contact your ImageNow administrator if you need new annotation templates.

Add an annotation
1. In ImageNow Viewer, open a document.
2. On the toolbar, right-click the annotation icon you want and select the form of the annotation from the list.
   
   Note: The Sticky Note and OLE icons require only a left mouse button click.
3. Click and hold the mouse button on the document image where you want to place the annotation.
4. Drag the annotation, as necessary, over the target area, and then release the mouse button.

For information on a specific annotation, see "Types of Annotations."

Show or hide annotations
The Show/Hide Annotations icon enables you to hide or restore all annotations. Hiding annotations enables you to view the original unmarked document without deleting the placed annotations.

1. In ImageNow Viewer, locate the document with the annotation you want to show or hide.
2. On the toolbar, click the Show/Hide Annotations icon.

Notes
To show or hide a specific annotation, right-click the annotation and select Show or Hide.
Closing the document with the annotations hidden does not delete the annotations. The annotations appear on the document the next time it is opened.

View annotation properties

In the ImageNow Viewer, right-click the annotation and select Properties to view the properties of the annotation instance, including creation and modification information.

Alternatively, for all annotations except OLE and Sticky Notes, you can double-click the annotation to view the properties.

Delete an annotation

You can delete individual annotations or delete all annotations. To temporarily remove the annotations while viewing a document, hide them.

Delete an individual annotation

1. In ImageNow Viewer, locate the document with the annotation you want to delete.
2. Right-click the annotation, and then select Delete.
3. In the confirmation dialog box, click Yes.

Note You can also CTRL+click or SHIFT+click to select multiple annotations and then delete them.

Delete all annotations

1. In ImageNow Viewer, open the document with the annotations you want to delete.
2. On the Annotation menu, click Select All.
3. On the Annotation menu, click Delete.
4. In the confirmation dialog box, click Yes.

Types of Annotations

Add an arrow annotation

In ImageNow Viewer, the Arrow icon annotation enables you to place an arrow on a document image.

1. In ImageNow Viewer, open a document.
2. On the toolbar, right-click the Arrow icon, and then select an arrow annotation from the list.
3. Click and hold the mouse button on the document image where you want to place the end of the arrow (the arrowhead appears at the other end).
4. While holding the mouse button, draw a line towards the area of the document to which you want the arrow to point.
5. Release the mouse button.

Add a check annotation

In ImageNow Viewer, the Check icon annotation enables you to place a check mark on a document image.

1. In ImageNow Viewer, open a document.
2. On the toolbar, right-click the Check icon, and then select a check annotation from the list.
3. Click the document image where you want the check mark to be placed.
Add a highlight annotation

In the ImageNow Viewer, the Highlight icon annotation enables you to highlight an area on a document image.

1. In the ImageNow Viewer, open a document.
2. On the toolbar, right-click the Highlight icon, and then select a highlight annotation from the list.
3. Click and hold the mouse button on the document image where you want to start highlighting.
4. While holding the mouse button, drag the mouse to select the area you want to highlight and then release the mouse button.

Add a line annotation

In ImageNow Viewer, the Line icon annotation enables you to place a line on a document image.

1. In ImageNow Viewer, open a document.
2. On the toolbar, right-click the Line icon, and then select a line annotation from the list.
3. Click and hold the mouse button on the document image where you want to start the line and, while holding the mouse button, draw a line, and then release the mouse button.

---

Add an oval annotation

In ImageNow Viewer, the Oval icon annotation enables you to place an oval on a document image. The oval annotation can appear hollow or filled, depending on the appearance defined in the annotation template.

1. In ImageNow Viewer, open a document.
2. On the toolbar, right-click the Oval icon, and then select an oval annotation from the list.
3. Click and hold the mouse button on the document image where you want to start the oval and, while holding the mouse button, draw the oval.
4. Release the mouse button.
Add a pen annotation

In ImageNow Viewer, the Pen icon annotation enables you to draw on a document image.

1. In ImageNow Viewer, open a document.
2. On the toolbar, right-click the Pen icon, and then select a pen annotation from the list.
3. Click the mouse button on the document image where you want to start the pen image and, while holding the mouse button, move the mouse to create the drawing.
4. Release the mouse button when you are finished.

Add a rectangle annotation

In ImageNow Viewer, the Rectangle icon annotation enables you to place a rectangle on a document image. The rectangle annotation can appear hollow or filled, depending on the appearance defined in the annotation template.

1. In ImageNow Viewer, open a document.
2. On the toolbar, right-click the Rectangle icon, and then select a rectangle annotation from the list.
3. Click and hold the mouse button on the document image where you want to start the rectangle and, while holding the mouse button, draw the rectangle.
4. Release the mouse button at the endpoint of the rectangle.

**Add a redact annotation**

1. In **ImageNow Viewer**, open a document.

2. On the toolbar, right-click the **Redact** icon , and then select a redact annotation from the list.

3. Click and hold the mouse button on the document where you want to start the redact rectangle and, while holding the mouse button, draw a rectangle.

4. Release the mouse button at the endpoint of the redact rectangle.

5. When you close the **ImageNow Viewer**, the **Save Redaction** dialog box appears. In the **Save Redaction** dialog box, add a key to describe the redaction. For example, in an empty key field, type **Redaction** and then click **OK**. This action saves a copy of the document that shows the redaction.
Add a stamp annotation

In **ImageNow Viewer**, the **Stamp** icon 📝 annotation enables you to stamp predefined (Approved, Confidential, Rejected, and so forth) or custom messages on document images.

1. In **ImageNow Viewer**, open a document.
2. On the toolbar, right-click the **Stamp** icon 📝, and then select a stamp annotation from the list.
3. Click the document image where you want the stamp to appear.

Add a sticky note annotation

In **ImageNow Viewer**, the **Sticky Note** icon 📝 annotation enables you to add small notes to document images.

1. In **ImageNow Viewer**, open a document.
2. On the toolbar, click the **Sticky Note** icon 📝.
3. Click the document image where you want the Sticky Note to appear.
4. In the **Sticky Note** dialog box, type your text and click **Add**. After you add text, you cannot change it.
5. Click **Close**.

**Notes**

To view the contents of an existing Sticky Note, double-click the Sticky Note on the document image. To print the text in an existing Sticky Note, double-click the Sticky Note on the document image and, in the **Sticky Note** dialog box, click **Print**.
Add a text annotation

In ImageNow Viewer, the Text icon \( \text{\texttt{\textsuperscript{1}}\texttt{\textsuperscript{1}}} \) annotation enables you to place text on document images.

1. In ImageNow Viewer, open a document.

2. On the toolbar, right-click the Text icon \( \text{\texttt{\textsuperscript{1}}\texttt{\textsuperscript{1}}} \), and then select a text annotation from the list.

3. Click the document image where you want the text to be placed.

4. Optional: In the Add Text dialog box, type your text message, and then click OK.

Add a URL annotation

In ImageNow Viewer, the URL icon \( \text{\texttt{\textsuperscript{1}}\texttt{\textsuperscript{1}}} \) annotation enables you to place a link to a URL address on a document image.
1. In ImageNow Viewer, open a document.

2. On the toolbar, right-click the URL icon, and then select a URL annotation from the list.

3. Click the document image.

4. If you are prompted to do so, in the URL dialog box, in Address, type the web address, in Text to Display, type the text you want to appear on the document image, and then click OK.

Add a sound or picture as an annotation

In ImageNow Viewer, the OLE annotation uses the Microsoft OLE (Object Linking Embedding) technology to insert objects as annotations. This technology enables you to insert sounds, pictures, or any other object supported by your system. There are two ways to insert an OLE Item into a document: create a new object or insert an existing object.

Insert an existing object

1. In ImageNow Viewer, open the document that you want to add the annotation to.

2. On the toolbar, click the OLE icon.

3. Click the mouse button on the document image where you want to insert an object.

4. In the Insert Object dialog box, select the Create from File option.

5. Use the Browse button to locate the object you want to insert.

6. Choose how you want the OLE document to display:
   - To display the document as an icon, select the Display As Icon checkbox. You can change the icon by clicking Change Icon. In the Change Icon dialog box, for the icon, select Current, Default, or Browse to the icon of your choice, then click OK.
   - Remove the checkbox selection to display an icon-sized version of the OLE document.

7. Optional. Select the Link checkbox to create a shortcut to the file so changes made outside of ImageNow are reflected in the document.

8. Click OK. The object appears as an icon in the document. Double-click the icon to open the object in its associated application.

Note To view the contents of an existing OLE annotation, double-click the annotation on the document image.

Create and insert an object

1. In ImageNow Viewer, open the document that you want to add the annotation to.

2. On the Annotation toolbar, click the OLE icon.

3. Click the mouse button on the document image where you want to insert an object.

4. In the Insert Object dialog box, select the Create New option.

5. Select the type of object you want to insert from the Object Type list.

6. Select the Display As Icon checkbox. Choose how you want the OLE document to display:
   - To display the document as an icon, select the Display As Icon checkbox. You can change the icon by clicking Change Icon. In the Change Icon dialog box, for the icon, select Current, Default, or Browse to the icon of your choice, then click OK.
   - Remove the checkbox selection to display an icon-sized version of the OLE document.
7. Click OK. The associated application of the object you selected starts.
8. In the associated application, create the object you want to insert.
9. When you are finished, close the associated application (you do not need to save). The object appears as an icon in the document. Double-click the icon to open the object in its associated application.

Customizing Annotations

Move or resize an annotation

Move an annotation

1. In ImageNow Viewer, on a document image, click and hold the mouse button on the selected annotation, drag the annotation to the location you want, and then release the mouse button.
2. Click outside of the annotation to deselect it.

Resize an annotation

1. In ImageNow Viewer, on a document image, click the annotation you want to resize. The annotation is outlined by a dotted line with large black squares.
2. Click and hold the mouse button on one of the black squares, drag to resize the annotation as needed, and then release the mouse button.
3. Click outside of the annotation to deselect it.

Note The Stamp, Text, and Sticky Note annotations cannot be resized.

Add a time, date, or user name code to a stamp annotation

You can insert the following codes in a stamp annotation to represent current time, dates, and user names. For example, the default code "%m/%d/%y" displays the current date (month/day/year).

The following codes are available:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>%%</td>
<td>Percent sign</td>
<td>%</td>
</tr>
<tr>
<td>%a</td>
<td>Abbreviated weekday name</td>
<td>FRI</td>
</tr>
<tr>
<td>%A</td>
<td>Full weekday name</td>
<td>FRIDAY</td>
</tr>
<tr>
<td>%b</td>
<td>Abbreviated month name</td>
<td>OCT</td>
</tr>
<tr>
<td>%B</td>
<td>Full month name</td>
<td>OCTOBER</td>
</tr>
<tr>
<td>%c</td>
<td>Date and time representation appropriate for locale</td>
<td>10/18/01 10:15:45</td>
</tr>
<tr>
<td>%d</td>
<td>Day of month as decimal number (01-31)</td>
<td>18</td>
</tr>
<tr>
<td>%H</td>
<td>Hour in 24-hour format (00-23)</td>
<td>22</td>
</tr>
<tr>
<td>%I</td>
<td>Hour in 12-hour format (01-12)</td>
<td>10</td>
</tr>
</tbody>
</table>
### Modify an annotation instance

You can modify the content and appearance of most annotations, except Sticky Note and OLE annotations.

1. In the **ImageNow Viewer**, right-click an annotation that appears on a document image, and then select **Appearance**.
2. In the **Appearance** dialog box, modify the available options, depending on the annotation type:
   - **Arrow**
     1. In **Line Weight**, select a number representing the width of the line.
     2. In **Line Color**, select a color.
   - **Check**
     - In **Fill Color**, select a color.
   - **Highlight**
     - In **Fill Color**, select a color.
   - **Line**
     1. In **Line Weight**, select a number representing the width of the line.
     2. In **Line Color**, select a color.
Oval
1. In **Line Weight**, select a number representing the width of the line.
2. In **Line Color**, select a color.
3. Select the **No Fill** checkbox to display the shape as an outline, or remove the selection to fill the shape with color. If **No Fill** is not selected, select a **Fill Color**.

Pen
1. In **Line Weight**, select a number representing the width of the line.
2. In **Line Color**, select a color.

Rectangle
1. In **Line Weight**, select a number representing the width of the line.
2. In **Line Color**, select a color.
3. Select the **No Fill** checkbox to display the shape as an outline, or remove the selection to fill the shape with color. If **No Fill** is not selected, select a **Fill Color**.

Stamp
1. To modify the content, in the left pane, select **Content**.
2. Click **Insert** to add a time or user code to the existing content.
3. In the **Insert Date/Time/User Code** dialog box, select a code to add, and then click **Insert**.
   
   **Note** Refer to the "Code variables for a custom stamp" topic for more information about the insertion codes.

Text
1. Modify any of the following options under **Font**:
   - In **Face**, select the typeface.
   - In **Style**, select the font style.
   - In **Size**, select the font size.
   - In **Color**, select the font color.
2. To modify the content, in the left pane, select **Content**, and modify any of the following:
   - In **Enter default text**, modify the text.
   - Click **Insert** to add a time or user code to the existing. In the **Insert Date/Time/User Code** dialog box, select a code to add, and then click **Insert**.

URL
1. Modify any of the following options under **Font**:
   - In **Face**, select the typeface.
   - In **Size**, select the font size.
   - In **Color**, select the font color.
2. To modify the content, in the left pane, select **Content**, and modify any of the following:
   - In **Address**, type the web address to open.
   - In **Text to Display**, type the text you want to appear on the document image.
3. After you finish modifying the annotation, click **OK**.
4. Optional. To edit a Sticky Note, double-click the sticky note, in the **Sticky Note** dialog box, type your text and click **Add**, then click **Close**.
Workflow

About ImageNow Workflow

ImageNow Workflow provides end-users with the ability to route a document through a business process from start to finish with a customizable set of options. As a user of workflow, you can place documents into workflow and move them through your business processes. As a workflow user, you can add a document to workflow, route it, respond to alarms and messages about the status of your items, and process it by, for example, viewing or annotating it. With almost any task in workflow, you have more than one way to complete it. Choose the path that best works for you. For example, you can

Add an item to workflow

2. In the ImageNow Explorer, on the Simple search tab, set the Search lists and field to the criteria you need to retrieve your document, and then click Go.
3. From the search results, double-click a document to open it.
4. In the ImageNow Viewer, verify that this document is the one you want to add to workflow.
5. Verify that the Document Tasks pane is open.
   How?
   • To display the Document Tasks pane, in the ImageNow Viewer, on the View menu, click Tasks.
6. In the Document Tasks pane, click Add this document to workflow.
7. In the Add to Workflow window, select a process, select a queue, select a priority, and then click Add.

Tip

In the document grid, you can add any document in a queue by selecting the document, right-clicking on the document, and then clicking Add to Workflow in the menu.

Remove an item from workflow

2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the ImageNow Viewer, verify that this document is the one you want to remove from workflow.
5. Verify that the Workflow Tasks pane is open.
   How?
   • To display the Workflow Tasks pane, in the ImageNow Viewer, on the View menu, click Tasks.
6. In the Workflow Tasks pane, click Remove this item from workflow.
7. In the Remove from Workflow confirmation box, click Yes to remove the item.
Tip

In the document grid, you can add any document in a queue by selecting the document, right-clicking on the document, pointing to Workflow, and then clicking Remove from Workflow in the menu.

Archive an item in workflow

2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the ImageNow Viewer, verify that this document is the one you want.
5. Verify that the Workflow Tasks pane is open.
   How?
   • To display the Workflow Tasks pane, in the ImageNow Viewer, on the View menu, click Tasks.
6. In the Workflow Tasks pane, click Archive this item and then, in the confirmation box, click Yes.

Change document keys in workflow

You can change the DocKeys in a document that resides in a workflow queue if the applet properties for the queue are set to allow linking from the queue. If this option is not available, contact your ImageNow administrator to set up this linking.

2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the ImageNow Viewer, verify that this document is the one you want.
5. In the Document Keys pane, change the DocKeys as needed.
6. Close the document, and then in the confirmation box, click Yes.

Route a document in workflow

2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the ImageNow Viewer, verify that this document is the one you want to route to a different queue.
5. Verify that the Workflow Tasks pane is open.
   How?
   • To display the Workflow Tasks pane, in the ImageNow Viewer, on the View menu, click Tasks.
6. On the Workflow Tasks pane, perform one of the following:
   • To send the document to the next queue in the workflow process flow, click Route forward.
   • To send the document back to any queue from which it came previously, click Route Up.
• To send the document back to the previous queue, click **Route Back**.
• To select a queue in the workflow process to which to send the document, click **Route Anywhere**.

**Tip**

In the workflow grid, you can route any document in a queue by selecting the document, and right-clicking on the document, and then clicking the routing option you want in the menu.

### Set the status of a document in workflow

1. On the **ImageNow** toolbar, click **Workflow**.
2. In the **ImageNow Explorer**, in the left pane under **Workflow**, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the Workflow grid, right-click the document, point to Workflow and select one of the following options:
   - Mark item as idle
   - Mark item as on hold
   - Mark item as pending
5. In the confirmation box, click **Yes**.

### View an item in workflow

1. On the **ImageNow** toolbar, click **Workflow**.
2. In the **ImageNow Explorer**, in the left pane under **Workflow**, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.

### Recall an item in workflow

1. On the **ImageNow** toolbar, click **Workflow**.
2. In the **ImageNow Explorer**, in the left pane under **Workflow**, select the workflow queue you want.
3. In the Workflow grid, right-click a document, click **Workflow**, and then click **Recall workflow item**.

### Place a workflow item on hold

If you are in the middle of processing a document but need to stop, you can place a workflow item on hold.

• In the **ImageNow Viewer - Workflow** mode, click to close the viewer and when you get a prompt, click **Put on Hold**, and then in the **Hold Item** dialog box, enter the date, reason, and any comments.
View recently routed items
2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the ImageNow Viewer, verify that this document is the one you want.
5. Verify that the Workflow Tasks pane is open.
   How?
   • To display the Workflow Tasks pane, in the ImageNow Viewer, on the View menu, click Tasks.
6. In the Workflow Tasks pane, click View recently routed items.

View workflow history
2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the ImageNow Viewer, verify that this document is the one you want.
5. Verify that the Workflow Tasks pane is open.
   How?
   • To display the Workflow Tasks pane, in the ImageNow Viewer, on the View menu, click Tasks.
6. In the Workflow Tasks pane, click View workflow history.
7. In the Document Properties dialog box, view the workflow item history, and then click OK.

Process an item in workflow
To process an item in workflow, the Process privilege is required for the queues you want to work with.
1. Verify that the document is added to workflow.
2. From the ImageNow toolbar, click Documents, and then search for the document you want to process.
3. In ImageNow Explorer, in Documents view, right-click the document you want to process, and then click Open in Workflow.
4. In the ImageNow Viewer - Workflow mode, do one or more of the following:
   • View the document
   • Add any annotations
   • Rotate and/or resize the document
   • Apply any other options you want available in the Viewer
5. On the File menu, click Close Viewer, and then return to the ImageNow Explorer or main toolbar.
View columns for Workflow

The columns you can view on workflow vary depending on your view.

- In the ImageNow Explorer, in Documents or Workflow view, right-click one of the column headers. On the shortcut menu, point to Columns, and then choose the columns you want.

Mark an item as pending

2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, right-click the document, select Workflow, and then click Mark Item as Pending.
4. In the confirmation box, click Yes.

Workflow toolbar options

Use the workflow toolbar buttons to perform the following tasks:

- View the next Item in the queue.
- Relink the item
- Send the document back to any queue in which it resided previously.
- Send the document back to the previous queue.
- Send the document to the next queue in the workflow process flow.
- Route the item anywhere
- Recall the item
- Mark the item as on hold
- Mark the item as pending
- Archive item
- Remove item from workflow
- View history
View recent
Viewing Log Files

What is the Controller Log file?
If you detect a problem in your ImageNow system, you can enable logging on the ImageNow Client to find the cause of the error. The Controller Log tracks user events and saves them on the ImageNow Server. After you log the error, you can view the log and resolve the problem, or send the log files to Technical Services for further help. The ImageNow Controller log tracks activities on the ImageNow Client and can be turned on or off, viewed, and deleted by any client user.

Create the Controller Log file
1. Hold down the SHIFT key and right-click in the ImageNow title bar.
2. If there is no check next to Controller Log On/Off, click it. Otherwise, the Controller Log file is already active.

View the Controller Log file
1. Hold down the SHIFT key and right-click in the ImageNow title bar.
2. Click View Controller Log.

Delete the Controller Log file
1. Hold down the SHIFT key and right-click in the ImageNow title bar.
2. Click Delete Controller Log.
Projects

What is a Project?

Projects allow you to group documents together according to a logic that you and the administrator define. While ImageNow documents continue to be grouped or categorized by index keys (DocKeys), Projects provide another way to let you group or filter on documents independently of these indexes. Based on a Project Type set up by a user with Project Type creation and (typically) management privileges, new Projects can then be created by users. Projects are document-centric. You cannot create a Project outside of the context of first retrieving and selecting one or more documents. When you locate the documents that you want to add to a Project -- either from ImageNow Explorer or ImageNow Viewer, then you can assign them to a Project of a certain Project Type. If no Projects are created, you will need to create one after first selecting the documents you want to categorize in this way.

For example, a Project Type might be "New Hires" and a new Project might be "John Jones." The documents you want to add to the John Jones project are his resume, employment application, W-4 and healthcare forms. One advantage of the Project design is that Project Types can contain criteria and other metadata, such as assigned doc types and other customized properties, that assist users in their review of documents grouped by Project. For example again, the New Hires Project Type would be set up with attributes to ensure that all the document requirements for that type are met before the John Jones Project can be considered complete.

After documents are assigned to Projects, you can search for Projects based on its properties in ImageNow Explorer. You can conduct various tasks on them from the ImageNow Project Viewer. For example, from the Project Viewer, you can conduct numerous tasks such as to modify the General Properties and Custom Properties, and work with documents as you normally would using the options provided in the Document Tasks pane evident in all ImageNow viewing modes. For an example, see the following figure. Projects will most likely be used for student folders, financial claim packages, and document management users who like to keep related items together in a folder-like context.
Projects

Security for Projects follows the model for using any feature in ImageNow: Users can perform functions to which they are assigned through privileges. To work with Projects, you will need one or more of these Project-specific privileges set: View, Create, Delete, Edit Properties, Add Documents and Remove Documents, along with any other privileges for working with documents that are exposed through the ImageNow Project Viewer via the task panes. Since Projects are based on the Project Type you specify, you will also need the Use privilege for the Project Types you want to work with. If you have all of the Project-specific privileges set but you do not have the Use privilege set for the Project Types you need, you will not be able to work with Projects.

Create a Project

To create a Project, you must have the "Create" Project Privilege set and the Use privilege set for the Project Types you need to work with. To set these privileges up for you, a user who is the Owner, or a Manager, or a user with management privileges for the relevant Projects options is required.

1. From the ImageNow toolbar, click Documents, and search for the one or more documents that you want to add to a project.
2. In ImageNow Explorer, from the search results list, select the documents, right-click, and then choose Add to Project.
3. In the Add to Project dialog box, select a project name from the field, and then click Add.
4. In the ImageNow Project Viewer, conduct any project or document tasks you want according to the options in the task panes and menus.

Add a document to a Project

To add documents to a Project, you must have the Add documents privilege and the Use privilege set for the Project Types you need to work with. To set these privileges up for you, a user who is the Owner, or a Manager, or a user with management privileges for the relevant Projects options is required. You can add one or more documents to a Project from ImageNow Explorer or ImageNow Viewer. Once you open a document in the ImageNow Viewer that is assigned to a Project, you can add it to another Project if needed.
• Add one or more documents to a Project from ImageNow Explorer
  1. From the ImageNow toolbar, click Documents, and search for the one or more documents that you want to add to a project.
  2. In ImageNow Explorer, from the search results list, select the documents, right-click, and then choose Add to Project.
  3. In the Add to Project dialog box, select a project name from the field, and then click Add.
  4. In the ImageNow Project Viewer, conduct any project or document tasks you want according to the options in the task panes and menus.

• Add a document to a Project from ImageNow Viewer
  1. From the ImageNow toolbar, click Documents, and search for the one or more documents that you want to add to a project.
  2. Double-click the document to open it in ImageNow Viewer.
  3. In ImageNow Viewer, from the Projects menu, click Add to Project.
  4. In the Add to Project dialog box, select a project name from the field, and then click Add.
  5. In the ImageNow Project Viewer, conduct any project or document tasks you want according to the options in the task panes and menus.

Remove a document from a Project
To complete this task, you must have the Remove Documents for Projects assigned to you, and the Use privilege set for the Project Type(s) to which this Project belongs. To set up these privileges for you, a user who is the Owner, or a Manager, or a user with management privileges of Projects is required. When you remove a document from a project, it still resides in the ImageNow system; you can retrieve it again, and add to another project as needed.

  1. From the ImageNow toolbar, click Projects, and search for Project containing the document you want to remove.
  2. In ImageNow Explorer, double-click the Project to open it.
  3. In the ImageNow Project Viewer, select the document you want to remove, and then in the Document Tasks pane, click Remove this document from a project.
  4. In the Remove from Project dialog box, select the Project name containing this document, and then click Remove.
  5. Repeat steps 2 through 4 to remove additional documents.

Delete a Project
You need the Delete privilege set for you in order to delete a project, in addition to the Use privilege set for the Project Type that the Project you want to delete belongs to. Deleting a Project does not delete the documents contained in that Project. You can delete multiple Projects if you have Delete privileges for the various Project Types to which they correspond. You can delete a Project from ImageNow Explorer or the ImageNow Project Viewer.
Projects

• **Delete a Project from ImageNow Explorer**
  1. From the ImageNow toolbar, click **Projects**.
  2. From the Simple tab, filter on Active projects, and then in the Where field, choose from Name, Type or Custom Property, and then select the corresponding criteria for each of these constraints.
  3. In the **created in last X days**, enter the number days.
  4. Click Go, and then from the list of Project names, right-click and choose **Delete**.
  **Note** If the Delete option is grayed out on the right-click menu, on the Explorer toolbar, click **Refresh** to enable it.

• **Delete a Project from ImageNow Project Viewer**
  1. From the ImageNow toolbar, click **Projects**.
  2. From the Simple tab, filter on Active projects, and then in the Where field, choose from Name, Type or Custom Property, and then select the corresponding criteria for each of these constraints.
  3. In the **created in last X days**, enter the number days.
  4. Click Go, and then from the list of Project names, double-click the Project you want to delete.
  5. In the **Project Viewer**, in the **Projects** task pane, click **Delete this Project**.
  6. Click **Yes** to verify your deletion.

**Add a Project to workflow**

A Project Type must be created by an Owner, Manager, or User with the required Project Type creation privileges in order to add a Project to workflow. You also need to have the Use Project Type privilege in order to add documents to a Project of its associated Project Type. This procedure assumes that you have a Project and Project Type(s) already set up in order to add a Project to workflow. A Project sent to workflow must contain documents.

  1. From the ImageNow toolbar, click **Projects**.
  2. From the Simple tab, filter on Active projects, and then in the Where field, choose from Name, Type or Custom Property, and then select the corresponding criteria for each of these constraints.
  3. In the **created in last X days**, enter the number days.
  4. Click Go, and then from the list of Project names, select a Project, right-click it, and then select **Add to Workflow**.
  5. In the **Add to Workflow** dialog box, in the **Select a process** list, choose the workflow process in which you want to add this Project.
  6. From the list, select the workflow queue in the select process, set the priority level, and then click **Add**.
Modify general properties of a Project

To change the custom properties on a Project you will need to have the Edit Properties privilege set, in addition to the Use privilege for the Project Type this Project belongs to.

1. From the ImageNow toolbar, click Projects.
2. From the Simple tab, filter on Active projects, and then in the Where field, choose from Name, Type or Custom Property, and then select the corresponding criteria for each of these constraints.
3. In the created in last X days, enter the number days.
4. Click Go, and then from the list of Project names, double-click the Project you want to delete.
5. In the Project Viewer, in the Properties task pane, under General Properties, change any of the following options:
   - Rename the Project.
   - Change the Project Type this Project is assigned to -- you must have Use privilege in order to change a Project's type.
   - Change the status: Active or Inactive.
   - Click More, and then in the Project Properties pane, add Notes for each document in the Project, and you can view its Custom Properties. Click OK to close.
6. When finished changing the properties, close the ImageNow Project Viewer.

Search and view documents by Project

To search for documents by Project, those documents must first be added to one or more Projects. Those Projects, therefore, must be created and its corresponding Project Types be set up by the administrator.

1. From the ImageNow toolbar, click Projects.
2. From the Simple tab, filter on Active projects, and then in the Where field, choose from Name, Type or Custom Property, and then select the corresponding criteria for each of these constraints.
3. In the created in last X days, enter the number days.
4. Click Go, and then from the list of Project names that return, double-click the one you want to work on.

Change custom properties on a Project

To change the custom properties on a Project you will need to have the Edit Properties privilege set, in addition to the Use privilege for the Project Type this Project belongs to.

1. From the ImageNow toolbar, click Projects.
2. From the Simple tab, filter on Active projects, and then in the Where field, choose from Name, Type or Custom Property, and then select the corresponding criteria for each of these constraints.
3. In the created in last X days, enter the number days.
4. Click Go, and then from the list of Project names, double-click the Project you want to delete.
5. In the Project Viewer, in the Properties task pane, under Custom Properties, change one or more properties: Click in the field next to each property name, and then type your revision.
6. When are finished making changes, close the ImageNow Project Viewer. Your changes will save automatically.

**View related Projects**

1. From the ImageNow Viewer, on the Projects menu, click View Related Projects.
2. In the View Related Projects dialog box, select a Project name, and then click View.
3. In the ImageNow Project Viewer, view the projects related by that Project Type.
Custom Properties

What are custom properties?
Custom properties are property fields you can populate with data relating to an ImageNow document. Custom properties provide the ability to store unlimited data related to an ImageNow document or project. This is especially useful since the document keys (DocKeys) are limited to 6 keys. Custom properties are viewed in the ImageNow Viewer, Project Viewer, and the WebNow Viewer in the Properties pane. You can execute a simple search to locate documents based on custom property values in either the ImageNow Explorer or WebNow Explorer. All custom properties for a document are associated with the document record.

Custom properties are an optional, core component of ImageNow. Whether custom properties are available for your use depends on if your ImageNow administrator defined some custom properties for your implementation of ImageNow. Contact your ImageNow administrator to determine if you have any custom properties available in your implementation. If so, your administrator can tell you which custom properties are available and the document types and projects to which they are associated.

View custom property data
1. On the **ImageNow** toolbar, click **Documents**.
2. In the **ImageNow Explorer**, on the **Simple** search tab, set the **Search** lists and field to the criteria to retrieve the document you want, and then click **Go**.
3. In the Documents grid, in the results set, double-click the document to open it in **ImageNow Viewer**.
4. Verify that the **Properties** pane is open.
   **How?**
   - To display the Properties pane, in the ImageNow Viewer, on the **View** menu, click **Properties**.
5. Verify that the **Custom Properties** section in the **Properties** pane is open.
   **How?**
   - In the **Properties** pane, in the **Custom Properties** section, click the double downward arrows to open it.
6. When you finish viewing the data, close **ImageNow Viewer**.

Edit custom property data
1. On the **ImageNow** toolbar, click **Documents**.
2. In the **ImageNow Explorer**, on the **Simple** search tab, set the **Search** lists and field to the criteria to retrieve the document you want, and then click **Search**.
3. In the Documents grid, in the results set, double-click the document to open it in **ImageNow Viewer**.
4. Verify that the **Properties** pane is open.
   **How?**
   - To display the Properties pane, in the ImageNow Viewer, on the **View** menu, click **Properties**.
5. Verify that the **Custom Properties** section in the **Properties** pane is open.
   **How?**
• In the Properties pane, in the Custom Properties section, click the double downward arrows to open it.

6. Type data or select choices in the custom properties.
7. When you are finished entering data, close ImageNow Viewer.

Search on custom properties

2. In the ImageNow Explorer, on the Simple search tab, in the Filter where list, select Custom Property.
3. Optional: To filter your results, in the Select Custom Property dialog box, in the Select a document type list, select a document type.
4. In the Select a custom property list, click the custom property you want to search on and then click OK.
5. Next to the Filter where box, select an operator, select a value from the list box, select the number of days in the and created in last days check box, and then click Go.
   Note The available operators and the method for selecting the search value varies depending on the data type of the custom property on which you are searching.
6. In the Documents grid, in the results set, double-click the document to open it in ImageNow Viewer.

Tip
The custom property you want to search on may be already displayed in the Filter where list if you searched on it recently, and you can select it there in that case. The recently accessed list is reset each time you log out and log back in.
Document Management

What is Document Management?

Document Management gives you the ability to place documents into the ImageNow Version Control System, and then manage changes to a document during the content authoring process while ensuring the integrity of your documents at all times. Document Management also works with other ImageNow features such as its annotations, search, auditing and workflow. After editing a document, for example, you can then send it through workflow for review, approval, and signing using digital signatures. The ImageNow Document Management Suite consists of the core Document Library Services which are available from both the ImageNow desktop and web clients, and also via Message Agent, Perceptive Software’s web services offering.

The ImageNow Document Management suite is governed by distinct security privileges that are accessible to your ImageNow administrator. The Use Document Library Services privilege, for example, provides users with all of the basic functions for working with documents under Version Control such as to add documents to Version Control, to check them in and out for editing, and to set options such as to mark a document private or promote earlier versions to the current version. Three other privileges in ImageNow give you the ability to remove documents from Version Control, delete version history, or undo document check-outs of other users in the ImageNow system.
The Document Management toolbar is available in both the ImageNow Explorer and ImageNow Viewer. You can also use a right-click shortcut menu, task pane, or the standard File menu to access Document Management functions. Once a document is in Version Control, you can then edit it in ImageNow or its native application. ImageNow's Document Management supports most types of files including Microsoft Office documents (version 2000 or higher), Adobe file formats, and CAD.

### Add a document to Version Control

1. On the **ImageNow** toolbar, click **Documents**.
2. In the **ImageNow Explorer**, on the **Simple** search tab, set the **Search** lists and field to the criteria you need to retrieve your document, and then click **Go**.
3. From the search results, double-click a document to open it.
4. In the **ImageNow Viewer**, verify that this document is the one you want to add to Version Control.
5. On the **File** menu, point to **Version Control**, and then click **Add**.
6. In the **Add to Version Control** dialog box, type a comment, click the **More** button to verify that the **Mark as Private** check box is clear, and then click **OK**.

   **Note** In the ImageNow Viewer, after you add a document to Version Control, the Tasks pane to the left of your screen by default displays a Version Control section providing you with the various actions you take.

   **Tip**

   You can also add a selected document to Version Control from the **ImageNow Explorer** using the right-click shortcut menu.

### Check in or check out a document

1. On the **ImageNow** toolbar, click **Documents**.
2. In the **ImageNow Explorer**, on the **Simple** search tab, set the **Search** lists and field to the criteria to retrieve the document you want, and then click **Go**.
3. Select the document you want to check in or check out, and then on the **File** menu, point to **Version Control**, and click **Check-in** or **Check-out**, as appropriate.

   **Note** Depending on the state of the document, only one of these two options is active.

4. In the **Check-In** or **Check-Out** dialog box, add any comments, perform one of the following tasks, and then click **OK**.

   - To check out the document, verify that the **Get Local Copy** check box is clear.
   - To check in the document, verify that **Mark as Private** is clear. Optional: If you want to mark the document private where only you can see it, then select **Mark as Private**.

5. Refresh the Search grid and verify that the **Version Controlled** field status is updated.

   **Tip**

   You can alternatively check in or check out a selected document from the **ImageNow Explorer** using the right-click shortcut menu.
Edit a versioned document in its native application

Ensure that you have access to the annotations you need. If not contact your system administrator. You should observe at least one annotation template available to you on the Annotations toolbar.

1. In the ImageNow Explorer Sunflower window, on the Simple search tab, verify that the Search field is set to the criteria you want, and then click Go.

2. In the Search grid, select and then right-click the document you want, point to Version Control, and then click Check-out.

3. In the Check-out dialog box, keep the default setting checked to make a copy from the ImageNow Server local to your computer, add a comment, and then click OK.

4. Save your document to the Desktop. The document opens in the native application. For example, if you are editing a Microsoft Word document, it will open in Word.

5. Edit your document, save your changes, and then close your native application.

6. Back in the ImageNow Explorer Sunflower window, in the Search grid, for the document you just edited, verify the following:
   - Version Controlled status is a padlock with a check mark.
   - The Checked Out status is set to TRUE.
   - The Current Version of the document is now incremented by 1.

7. To check-in your document after editing, select and then right-click the document, point to Version Control, and then click Check-in. Add a comment and do not mark it as private. Click OK.

8. To view your latest version containing the changes you just made, double-click the document.

Apply annotations to a document in Version Control

Ensure that you have access to the annotations you need. If not, contact your system administrator. You should see at least one annotation template on the Annotations toolbar.


2. In the ImageNow Explorer, on the Simple search tab, set the Search lists or field to criteria you want to retrieve your image document, and then click Go.

3. From the search results, double-click to open the image document.

4. In the ImageNow Viewer, on the File menu, point to Version Control, and then click Add.

5. In the Tasks pane to the left of your screen (by default), under Version Control, click Check-out.

6. In the Check-out dialog box, add any comments, leave the Get Local Copy check box blank, and then click OK.

7. To edit the image, on the Annotations toolbar (now active because you have checked out the document), add an annotation.


9. In the Check-in dialog box, add any comments, verify that the Mark as Private check box is clear, and then click OK.

Mark a document "private" in Version Control

By marking a document private, only you can view and work on it in Version Control. Before starting this procedure, your document must be checked out.

1. With your document in a checked-out state and selected, from the File menu in either the ImageNow Viewer or ImageNow Explorer, point to Version Control, and then click Check-in.
2. In the Check-in dialog box, add comments, click the More button, and then select the Mark as Private check box.
3. Click OK. The Version History reflects that you marked the document as private.

Promote a document in Version Control

You can only promote a document when it is checked in to Version Control.

2. In the Document Properties dialog box, on the Version tab, select the version of this document that you want to make current, and then click Promote. The document you just promoted is copied to the top of the document hierarchy to create another version, which is now the current version of this document.
3. Click OK, and then close the ImageNow Viewer.
4. In the ImageNow Explorer, refresh your search results, and reopen the document to confirm that the version you promoted is now the current version.

Remove a document from Version Control

To remove a document from Version Control, it is required that you are assigned the Remove from Version Control privilege.

2. In the ImageNow Explorer, on the Simple search tab, set the Search lists and field to the criteria you need to retrieve your document, and then click Go.
3. From the search results, select your document, and then double-click to open it.
4. In the ImageNow Viewer, verify that this document is the one you want to remove from Version Control.
5. In the Tasks pane to the left of your screen (by default), under Version Control, click Remove from Version Control.
6. To retain the history on the document but still remove it from Version Control, leave the Retain Version History check box selected, and then click OK. The version history is stored in Document Properties.

Troubleshooting document management

I cannot check out a document, the option is grayed out.

You cannot check out a document:
• Unless a document selected in ImageNow Explorer.
• If you do not have the "User Library Services" privilege.
• If the document is already checked out, which you can verify by the ability to edit using annotations or from the ImageNow Explorer, Version Controlled field - a checked padlock icon.

**My document is in Version Control but I cannot add an annotation to it.**

Documents in Version Control must be checked out before you can use ImageNow annotations. You also need to be assigned permissions to use the annotations available on your toolbar.

**I see the Version Control toolbar, but I can't add a document to Version Control.**

You need to have the Document Management license and the Use Library Service privilege to use the Version Control feature in ImageNow. See your administrator for the **Use Library Services** privilege. Contact your PSI representative for the Document Management license.

**Undo a document check-out**

If after checking out a document you decide to cancel that action and not make a new version, you can undo the check-out. If you undo the check-out, any changes you made to the document since you checked it out are lost.

• With your document open in the **ImageNow Viewer** and checked out, in the **Tasks** pane, under **Version Control**, click **Undo check-out**. Click **OK**.

**View Version Control document properties**

The properties for Version Control are contained in the version history for each versioned document.

1. In the **ImageNow Explorer**, search for the document you want, and then double-click to open it.
2. In the **ImageNow Viewer**, in the **Tasks** pane to the left of your screen (by default), under **Version Control**, click **Version history**.
3. In the **Document Properties** dialog box, on the **Version** tab, view the version history for that document.

**Version Control Security Privileges**

There are four security privileges for Version Control:

**Use Library Services** Allows you to work with Version Control in ImageNow, specifically to conduct the following actions on documents in ImageNow: check in, check out, undo check-out, add a document to Version Control and view its properties, which includes the option to promote a document in order to make it the current version.

**Remove From Version Control** Lets you remove a document from version control and elect if you want to retrain the version history on that document.

**Undo 3rd Party Check-out** Lets a user undo a document that is checked out to another user. Basically, this is an override privilege in the event that you need to work on a document that, for various reasons, is not checked into Version Control.
Delete History If you remove a document from Version Control, the version history of that document is retained in ImageNow. If you have this Delete History privilege, however, you can also remove all history relating to a document that was once in Version Control.

View a document in Version Control

To view a document under Version Control, in the Search Grid, you simply double-click to open it as you would open any other document in ImageNow.

2. In the ImageNow Explorer, on the Simple search tab, set the Search field to the criteria you need to retrieve your document, and then click Go.
3. From the search results, select your document, and then double-click to open it.
4. In the ImageNow Viewer, view your document. To make any changes to this document, you must check it out.

View history on a document in Version Control

1. In the ImageNow Explorer, search for the document you want, and then double-click to open it.
2. In the ImageNow Viewer, in the Tasks pane to the left of your screen (by default), under Version Control, click Version history.
3. In the Document Properties dialog box, on the Version tab, view the version history for that document.
Worksheets

About worksheets

Worksheets are small forms that appear in the ImageNow Viewer in the Worksheets pane that allow you to capture additional data for your ImageNow document. You fill in a worksheet by typing data into the fields on the worksheet. Worksheet data might also be pre-populated for you by other ImageNow components. Certain security privileges are required for using worksheets. Contact your ImageNow administrator to obtain the necessary privileges for viewing, entering, modifying, and deleting worksheet data. Additionally, if your ImageNow administrator set up your worksheet so that the entered data populates custom properties in ImageNow, you can execute searches for the data in the Documents grid.

Worksheets are an optional, core component of ImageNow. Whether worksheets are available for your use depends on your implementation of ImageNow. Contact your ImageNow administrator to determine if you have any worksheets available in your implementation. If so, your administrator can tell you which worksheets are available and the workflow queues to which they are associated.

View a worksheet

2. In ImageNow Explorer, conduct your search, and then in the search results, double-click the document to open it in ImageNow Viewer.
3. Verify that the Worksheets pane is open.
   - To display the Worksheets pane, in the ImageNow Viewer, on the View menu, click Worksheets.
4. Verify that the worksheet you need is displayed.
   - How do I select a different worksheet than the one set as the default?
     - In the Worksheets pane, in the Worksheets list, select the worksheet.
5. When you are finished viewing data, close ImageNow Viewer.

Complete a worksheet

2. In ImageNow Explorer, conduct your search, and then in the search results, double-click the document to open it in ImageNow Viewer.
3. Verify that the Worksheets pane is open.
   - To display the Worksheets pane, in the ImageNow Viewer, on the View menu, click Worksheets.
4. Verify that the worksheet you need is displayed.
   - How do I select a different worksheet than the one set as the default?
     - In the Worksheets pane, in the Worksheets list, select the worksheet.
5. Type your data into the boxes on the worksheet.
6. When you are finished entering data, close the ImageNow Viewer.

Delete worksheet data
2. In ImageNow Explorer, conduct your search, and then in the search results, double-click the document to open it in ImageNow Viewer.
3. Verify that the Worksheets pane is open.
   How?
   • To display the Worksheets pane, in the ImageNow Viewer, on the View menu, click Worksheets.
4. Verify that the worksheet you need is displayed.
   How do I select a different worksheet than the one set as the default?
   • In the Worksheets pane, in the Worksheets list, select the worksheet.
5. Click the red X to delete the data associated with this document.
6. When you are finished, close ImageNow Viewer.
Index

A
accrue 46
add 15, 50, 64, 79
advanced search 42
alerts 36
annotations 50, 51, 52, 53, 54, 55, 56, 57, 58, 59, 60, 61, 62
applet 1, 2, 32
application original 13
archive 65
arrow annotation 51
attach a document 59

B
batch processing 18, 19, 36
block sections of a document 56

C
capture 32, 38, 39
check annotation 52
check in 79, 82
check out 79, 82
code variables 61
colors, how to reverse 14
columns in ImageNow Explorer 15
commit batch 19
content search 46, 49
Controller Log file 70
coordinates, XY 14
copy 16
copyright 11
custom properties 42, 76, 77

D
date 34
default view 13
defaults 32, 45
delete 15, 17, 20, 45, 51, 81, 85
discard a batch 20
DocKey 42
docking 40
document 12, 13, 14, 16, 17, 79
document keys 65
Document Management 78, 81

E
edit 80
e-mail 33
email 40

F
Fetch 38
Full text 46, 49

G
grid 15, 36

H
help 5, 32
hide annotations 50
highlight annotation 53
highlight color 49
history 67, 83
history of annotations 51
hold 67

I
icon 32
ImageNow Explorer 15, 36
ImageNow Viewer 38
insert an object 59
instance 62

K
keys 65

L
Launch 38
LearnMode 35
line annotation 54
link a document 19, 20, 21, 59
link to a website 59
log file 70

M
manage 32
marquee 33
menu bar 32
Message Center 33, 41
Microsoft Office 78, 80
modify an annotation 62
move an annotation 60
N
Natural Language 46
notes, adding to a document 13

O
OLE, 59
oval annotation 54
overlay 56

P
package mode 39
pages 13, 20, 38
pen annotation 55
pending 68
prefetch 38
print 39
privileges 83
process 67
product support 6
project 32
promote 81

Q
QA Mode 17
quality assurance 17, 18, 19
query 32, 42, 44, 45

R
recall 66
rectangle annotation 56
redaction 50, 56
refresh ImageNow Explorer grid 15
reimport a page 18
relink button 20
remove 64, 81
rename 45
rescan a page 18
resize 14, 60
reverse colors 14
rotate a document 14
route 65
run 44

S
save 44
scan 38
scroll 33
search 32, 36, 40, 42, 43, 45, 46
security 83
shortcut keys 8
show annotations 50
simple search 42
SMTP 33
split buttons 32
stamp annotation 57, 61
starts up 36
status 66
sticky note annotation 58
suspend 19, 21
System Tray 34, 35

T
task pane 40
Technical Support 6
text annotation 58, 61
text fill 38
theme 32
tile 13, 38
time 34
time and date codes 61
time constraint 45
toolbars 1, 2, 22, 24, 26, 27, 28, 29, 30, 32
trademark 11
troubleshooting 82

U
undo 82
URL annotation 59

V
Version Control 33, 80, 81, 82, 83
view 12, 13, 66, 67, 68, 83, 84
viewer 3, 24

W
workflow 32, 36, 64, 65, 66, 67, 68
workflow queue status 33
worksheet 84, 85

X
XY coordinates 14

Z
zoom in and out 14